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CHAPTER 1: Introduction
Hello, and welcome to “What’s New in 
Vision 4.5”.

The information in this manual is taken 
directly from the Vision 4.5 MIDI and 
Audio Reference manuals. There’s been 
some editing, but after reading this, the 
big books that come in the box will seem 
like old friends.

The purpose of this document is to 
acquaint you with what’s new in Vision 
4.5. If you already know every feature that 
Vision 4.2 has to offer (as we're sure you 
do), this supplement will get you up to 
speed on the new stuff you can do with 
Vision 4.5.

This manual consists of two parts.

• Part One: Completely new 
information.

• Part Two: Features and functions that 
have changed enough that you can 
think of them as new.

Please take a look at this document (espe-
cially Part One). It’s short; we promise.
Vision & Studio Vision Pro - What’s New in 4.5
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CHAPTER 2: Automation
This chapter discusses Vision’s automa-
tion capabilities. In this chapter you will 
learn about:

• how automation events work;
• recording automation events;
• viewing and inserting automation 

events;
• using the Copy Faders command;
• types of automation events.

WHO SHOULD READ THIS 
CHAPTER?

Everything in this chapter applies to 
Acadia users.

The Mutes and Solos, Audio Volume, and 
Audio Pan sections apply to DAE users. In 
addition, the Send Levels and Plug-In 
Bypass sections apply to Studio Vision 
Pro owners with TDM hardware.

This chapter also contains some informa-
tion about MIDI events, which apply to all 
audio systems.
Vision & Studio Vision Pro - What’s New in 4.5
HOW AUTOMATION EVENTS 
WORK

If you’re familiar with the way Vision has 
treated MIDI controller data and fader 
events in the past, then automation events 
should seem familiar. In fact, controller 
events themselves are automation events, 
and the handling of the new types of auto-
mation events is modeled after the 
handling of controller events in previous 
versions of Vision.

When Vision sends MIDI controller data 
to a MIDI instrument, the parameters of 
that instrument are being “automated”. 
When Vision sends any of the new types 
of automation events to an Audio Instru-
ment, send, plug-in, or EQ, it is 
automating those parameters.
3
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RECORDING AUTOMATION 
EVENTS

Basic Recording

Automation is recorded just as MIDI con-
troller information is recorded. There are 
three basic steps.

a Record enable a track.

b Press Record.

c Move a fader.

Alternately, you can drag or type in the 
numeric field of an automatable 
parameter.

The two main differences between record-
ing automation data now and recording 
controller data in previous versions are:
Vision & Studio Vision Pro - What’s New in 4.5
• You can now automate many, many 
more parameters. For example, EQ 
and plug-in parameters can be auto-
mated. For a complete list, see Types 
of Automation Events (pg. 15).

• Moving a fader assigned to a MIDI 
controller used to generate fader 
events (in versions of Vision prior to 
4.5). This action now generates con-
troller events (or other automation 
events) directly. For details, see 
Changes in the Way Vision Handles 
Faders (pg. 11).

Tip for Recording Plug-In 
Automation

To get a finer range of values for “face-
less” plug-in parameters, hold down the 
Option key while adjusting its sliders.

When the option key is not held down, 
moving the mouse by one pixel also 
moves the parameter slider one pixel. 
Parameter sliders (for faceless plug-ins) 
are 88 pixels wide, so there are 88 possi-
ble values for the parameter.
4



 

 

    
When the option key is held down, 
moving the mouse ten pixels moves 
parameter slider one pixel. This increases 
the number of available values for the 
parameter to 880.

Of course, you can type any number 
within the parameter’s range into its 
numeric field.
5

VIEWING AND INSERTING 
AUTOMATION EVENTS

Figure 1.1: Strip Chart contents menu

Figure 1.2: List window Insert menu

Figure 1.3: Automation-type submenus

The Strip Chart contents menu and the 
List window Insert menu both include the 
submenus shown in Figure 1.3. All of the 
types of automation discussed in this 
chapter are in these menus.
Opcode Systems, Inc.
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Figure 1.4: MIDI submenu

Figure 1.5: Automation submenu

Figure 1.6: EQ Band Parameter submenu

Figure 1.7: Plug-in Parameter submenu
Vision & Studio Vision Pro - What’s New in 4.5
The Plug-in Parameter submenu appears 
only if there are plug-ins assigned in the 
current sequence file. You must assign a 
plug-in (in a Console) before you can 
insert or view automation events for that 
plug-in. For information about how to 
assign plug-ins, please see page 47 in your 
Audio Reference Manual.

Automation Events in the List 
Window

For information about automation events 
in the List Window, see your MIDI Refer-
ence Manual.

Automation Events in the Strip 
Chart

For more information about automation 
events in the Strip Chart, see your MIDI 
Reference Manual.

Tracks and Pulse Window Strip Charts

In the Tracks and Pulse windows, the 
Strip chart intelligently allows you to 
insert only appropriate automation events. 

For example, if you're inserting plug-in 
parameter events, at least one instrument 
in a selected track must have that plug-in 
assigned to it in order to get a pencil.
6



 

 

         
If your Console looks like this:

Figure 1.8: Console setup

...and your Tracks window looks like this:

...you’ll have the following results.
7

Figure 1.9: Plugin 1 Bypass on a MIDI track

The pencil tool is not displayed when a 
MIDI track is selected and an audio auto-
mation parameter is displayed.

Figure 1.10: MIDI controller on a MIDI track

The pencil tool is displayed when a MIDI 
track is selected and a MIDI controller is 
displayed.

Figure 1.11: Plug-in parameter on an audio 
channel with no plug-in assigned

As shown in Figure 1.8 on page 7, there is 
no plug-in assigned to Bus 1 (the selected 
track’s instrument). So, the pencil tool is 

Selected Track Strip Chart contents
Opcode Systems, Inc.



 

CHAPTER 2: Automation

        
not displayed when Track 3 is selected 
and a plug-in parameter is chosen in the 
Strip Chart.

Figure 1.12: Plug-in parameter on an audio 
channel with a plug-in assigned

As shown in Figure 1.8 on page 7, there is 
a plug-in assigned to the selected track’s 
instrument (Audio 1). So, the pencil tool 
is displayed when Track 1 is selected and 
a plug-in parameter is chosen in the Strip 
Chart.

When more than one track is selected and 
the Strip Chart contents displays a value 
that is only appropriate for one (or more) 
of the instruments on the selected tracks, 
the pencil tool is displayed.

Figure 1.13: Strip Chart with multiple instruments 
selected
Vision & Studio Vision Pro - What’s New in 4.5
In Figure 1.13 and Figure 1.14, two tracks 
are selected: one MIDI track, and one 
audio track (assigned to Audio 1, which 
does have opCHORUS assigned). The 
pencil tool does appear in the Strip Chart.

However, when you draw information into 
the Strip Chart in this type of scenario, 
information is only inserted on the appro-
priate instrument. In this example, plug-in 
parameter events are inserted only on 
Audio 1.

Figure 1.14: Drawing Plug-In Parameter events 
with multiple instruments selected

Graphic window Strip Chart

The Strip Chart in the Graphic window 
works slightly differently.

In the Graphic Window, the Strip chart 
will always show a pencil. If you attempt 
to insert an event that is inappropriate for 
the selected track, or if the track is multi 
and more than one of the instruments in 
8



 

 

               
the track would be appropriate, a dialog 
will appear asking you which instrument 
you’d like the events to be inserted on. 
This dialog will display only appropriate 
instruments.

Figure 1.15: Graphic window Strip Chart with 
inappropriate contents

In the above case, the track’s instrument 
does not have the specified plug-in 
assigned to it. As soon as you draw in the 
Strip Chart, the following dialog appears.

Figure 1.16: Set Insert Instrument window

The only instrument available in the pop-
up is Audio-1, because it is the only instru-
ment with opCHORUS assigned to it (as 
shown in Figure 1.8 on page 7).

NOTE: If a MIDI controller had been 
selected in the Strip Chart Contents pop-up, 
the instrument pop-up in Figure 1.16 
would have shown all MIDI Instruments.

Strip Chart contents Selected trackÕs instrument
9

After inserting events assigned to 
Audio-1, the track becomes a multi track.

For more information about viewing and 
inserting events in the Strip Chart, see 
your MIDI Reference Manual.

Notes about Audio Volume

The Maximum Fader Position setting 
(see page 89 in your Audio Reference 
Manual for Acadia users, page 173 in 
your Audio Reference Manual for DAE 
users) determines the uppermost value of 
an audio volume fader in the Console 
window.

It also determines the uppermost value 
for audio volume displayed in the Strip 
Chart.

Track is now ÒmultiÓ
Opcode Systems, Inc.
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For example, when the Maximum Fader 
Position is set to +6 dB and Audio Volume 
is selected in the Strip Chart Contents 
pop-up, the Strip Chart looks like this.

The range is from -¥ to +6 dB. A horizon-
tal line is also drawn (for your reference) 
at 0 dB.

However, regardless of the Maximum 
Fader Position setting, Audio Volume 
events in the List window can always have 
values up to +24 dB in Acadia mode or 
+6 dB in DAE mode. Values above the 
current Maximum Fader Position setting 
can never be recorded; they can only be 
inserted in the List window.

The Maximum Fader Position setting 
should be made at the beginning of your 
session and left at that setting for the 
duration of the session.

The Maximum Fader Position setting 
does not directly affect audio volume 
events or the perceived volume of any 
audio events. Instead, it allows you to 
manually adjust audio volume more flexi-
bly. This setting can be considered 
“cosmetic”, because it affects only the 
appearance of the Consoles, Faders win-
dow, and Strip Chart.
Vision & Studio Vision Pro - What’s New in 4.5
If you lower the Maximum Fader Position 
during a session, visual settings in the 
Consoles, Faders window, and Strip Chart 
may appear misleading as a result. How-
ever, the audio volume events themselves 
will not be affected, and audio will sound 
as it did before the change. The List 
window always displays numeric values 
accurately, so audio volume events in the 
List window will appear as they did before 
the Maximum Fader Position was 
adjusted.

Audio Volume and Pan in the Faders 
Window

As in previous versions of Vision, audio 
volume and pan can be displayed in the 
Faders window and controlled by its 
sliders.

Audio pan now has a range of -100.00 to 
100.00, and audio volume now has a range 
of -¥ to the Maximum Fader Position (as 
set in the Audio Preferences dialog box). 
However, displayed numeric values in the 
Faders window are still 0-127.

These values are mapped to the appropri-
ate range of values for the selected 
parameter. In the case of audio pan, 0 cor-
responds to -100.00 (left) and 127 
corresponds to 100.00 (right). For audio 
volume, 0 corresponds to -¥ and 127 cor-
responds to the Maximum Fader 
Position.

If you wish to see the correct numeric 
values for these parameters, use the Con-
soles rather than the Faders window.
10



 

 

                 
CHANGES IN THE WAY VISION 
HANDLES FADERS

Removal of “Fader Events”

In previous versions of Vision, faders 
were a type of interface between you and 
your MIDI controller data.

Figure 1.17: The old way

Faders still act as an interface, but now 
they generate data directly. Instead of cre-
ating a fader event assigned to another 
parameter (such as a controller), faders 
now create automation events.

Figure 1.18: The new way

In short, we’ve “eliminated the middle-
man” by completely removing “fader 
events”.

A fader set up like this...

...used to generate an event like this
(in the List Window).

A fader set up like this...

...will now generate an event like this
(in the List Window).
11
Visual and Audible Effect

In most cases, the visual and audible 
effects of recorded fader movements will 
not change. In fact, faders themselves 
have become much more flexible. For 
example:

a Open the Faders window and assign 
the first fader to control pan for an 
instrument.

This example uses JD-800-1.

b Record enable a track.

c Press the Record button.

d Click on the fader and drag it back 
and forth to record pan information.
Opcode Systems, Inc.
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e Press the Stop button and open the 
List window.

You can see the pan events in the List 
window.

Notice that these are not fader events 
assigned to pan; they are pan events.

f Press Play

Watch the first fader move just as you 
recorded it.

g Disable the first fader by clicking on 
its selector dot.

h Enable a different fader and set it to 
JD-800-1 Pan.

i Press Play.

Now the new fader moves to the 
recorded pan events.
Vision & Studio Vision Pro - What’s New in 4.5
You could also assign a Console channel 
to JD-800-1 and the pan fader in that con-
sole would move in unison as well.

Although this example uses a MIDI 
instrument, the same principles apply 
when dealing with audio instruments.

See your MIDI Reference Manual for 
more details.

COPY FADERS AND AUDIO 
CHANNELS

The Copy Faders command is an excel-
lent way to create a “fader snapshot” to 
put at the beginning of your sequence. 
Inserting an initial setting for each fader is 
very important, but it is often overlooked.

For example, you might use volume 
faders to create a “fade out” at the end of a 
song, with each instrument’s volume set-
ting ending at 0. The first time the 
sequence is played, it sounds correct. 
After the sequence ends, you press play 
again, but can’t hear anything. If you let 
the sequence play long enough, you’ll 
hear only the fade out.

This happens because, at the end of the 
song, each instrument receives a volume 
setting of 0. If there’s no volume data at 
the beginning of the sequence, the instru-
ment doesn’t know to change its volume 
until the first volume event of the fade out. 
Creating a set of initial volume settings (a 
“snapshot” of the Console and Faders 
windows) will alleviate this problem.
12



 

Of course, the same principles apply to 
mutes and solos, send levels, pan, EQ 
parameters, plug-in parameters, etc.

For basic information about Copy Fad-
ers, see your MIDI Reference Manual.

Copy Faders now includes many more 
parameters than it used to. Following are 
some scenarios. These figures include 
Console strips and the events that appear 
in the List window after using Copy 
Faders.

Example 1: Basic Console Strip

Figure 1.19: Copy Faders Example 1

Phase Invert, EQ Enable, Mute, Solo, Vol-
ume, and Pan will always be copied for 
each audio channel, regardless of any 
other parameters.

Since there are no sends or plug-ins 
assigned, no events are written for those 
options.

No send here; no send level event.

No plug-in here; no plug-in parameter events.
13
Example 2: Solo, Phase Invert, 
and a Send

Figure 1.20: Copy Faders Example 2

In example 2, phase invert and solo have 
been turned on, and a send has been 
assigned. Note that the List Window dis-
plays “Send 1 Level” regardless of the 
destination of the Send (it doesn’t say 
“Send to Bus 1 Level”).
Opcode Systems, Inc.
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Example 3: EQ Enabled

Figure 1.21: Copy Faders Example 3

In example 3, EQ Enable has been set to 
On. As a result, Vision checks the On/Off 
status of each of the 4 EQ bands.

The first band is turned On, so Vision 
includes the settings for each of its param-
eters when the faders are copied.

Each of the remaining bands is turned 
Off, so Vision does not check the settings 
for any of their parameters.

In general, if a parameter is set to Off, 
none of its sub-parameters will be copied.
Vision & Studio Vision Pro - What’s New in 4.5
However, the sub-parameters of disabled 
parameters can still be recorded and 
inserted (in the List window or Strip 
Chart).

Example 4: A Plug-In

The Copy Faders command does not 
copy plug-in parameter settings when a 
Console (or the Faders window) is active.

Figure 1.22: Copy Faders with a Console window 
active

As you can see, the plug-in’s bypass status 
is copied. Plug-in bypass is not considered 
a plug-in parameter. None of the plug-in 
parameters (Dry/Wet, Filter, etc.) have 
been copied.
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If you wish to copy a plug-in’s parameter 
settings, make the plug-in edit window 
active before choosing Copy Faders. This 
will copy only plug-in parameter data.

Figure 1.23: Copy Faders with a Plug-In Edit 
window active

If a plug-in (with automation data 
assigned to it) is removed from a Console, 
a warning dialog will appear.

Clicking Cancel will leave the plug-in in 
the Console. Clicking OK will remove the 
plug-in and all automation data assigned 
to it.
15
Copy Faders and “Faced” Plug-Ins

When used with the plug-in edit window 
of a faced plug-in active, Copy Faders 
includes values for all 1024 of the plug-in’s 
parameters. Of course, you can delete the 
values for any parameters that are not 
actually in use by the specified plug-in. 
Parameters that are not in use usually 
have values of 0. See page 21 for more 
information about faced plug-ins.

TYPES OF AUTOMATION 
EVENTS

There are several types of events that can 
be automated. They include:

• Audio volume;
• Audio pan;
• Mute and solo;
• Send levels;
• Plug-in bypasses;
• Phase invert;
• EQ enable;
• EQ band parameters;
• Plug-in parameters;
• MIDI controller data;
• other continuous MIDI events, 

including velocity scale, pitch bend, 
aftertouch, and poly aftertouch.

Unless otherwise noted, these events can 
be assigned to Audio Instruments, Bus-
ses, Inputs, or Outputs, referred to as 
audio channels.
Opcode Systems, Inc.
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Automation

The Automation submenu contains the 
following types of events:

• Audio Volume
Audio Volume events effect the play-
back volume level of Audio 
Instruments, Busses, Inputs, and 
Outputs.
Audio volume events can have values 
ranging from -¥  to +24 dB. However, 
since the Maximum Fader Position 
setting defines the maximum value 
that can be displayed in the Consoles 
(or the Faders window), audio chan-
nels in Consoles can only have values 
ranging from -¥  to the Maximum 
Fader Position setting. The Maxi-
mum Fader Position can be 0, +6, 
+12, or +18 dB. This setting is defined 
under Audio>Audio Preferences. 
For information about Maximum 
Fader Position in Acadia mode, see 
page 89 in your Audio Reference Man-
Vision & Studio Vision Pro - What’s New in 4.5
ual. For information about Maximum 
Fader Position in DAE mode, see 
page 173 in your Audio Reference 
Manual.
In previous versions of Vision, audio 
volume events had the same 0 to 127 
range that MIDI volume events have. 
When files created in previous ver-
sions of Vision are opened into 
version 4.5 (or later), their audio 
volume events (or fader events 
assigned to volume for an audio 
instrument) are remapped to take 
advantage of the new range of audio 
volume values.

• Audio Pan
Audio pan events effect the placement 
of audio events in the stereo field (left 
to right).
Audio pan events can have values 
ranging from -100.000 to 100.000. 
These events work just like MIDI pan 
events, but can be much more spe-
cific and are assigned to audio 
instruments.
MIDI events have pan values from -64 
to 63 (which adds up to a total of 128 
possible settings, just like all other 
MIDI controllers). In previous ver-
sions of Vision, audio pan events had 
the same values. When files created 
16



 

in previous versions are opened into 
Vision 4.5 (or later), audio pan data 
will be remapped to take advantage of 
the full -100 to +100 range.
In addition to the increased sensitiv-
ity, having audio pan displayed with 
this range makes it easy to distin-
guish at a glance whether you’re 
dealing with audio or MIDI pan data.
Audio pan events are displayed with 
two decimal points in the Consoles 
window and with three decimal points 
in the List window.

• Mute and Solo
Mute and Solo events control the on/
off status of the chosen Instrument’s 
Mute and Solo settings.
Unlike most of the other commands 
in this menu, Mute and Solo can 
affect Audio or MIDI Instruments. 
Keep in mind that these events affect 
Instruments rather than tracks.
For more information about the simi-
larities and differences between 
tracks and instruments when muting 
and soloing, please see your MIDI 
Reference Manual.
17
• Send Levels

Send level events control the level of 
audio sent to a specific send. Sends 
are addressed by number, so even if 
you change the output of a send, the 
automation data will remain.
Send level events can have values 
ranging from -¥ to +24 dB.

• Plug-In Bypass

Plug-in bypass events control the 
status of the chosen plug-in’s bypass 
button.
These events can have values of Off 
or On. When set to off, the plug-in’s 
bypass button is out, and the plug-in 
effects the audio that passes through 
it. When set to on, the plug-in bypass 
button is in, and the plug-in is 
bypassed (and does not effect the 
audio).
For more information about bypass-
ing plug-ins, see page 51 in your 
Audio Reference Manual.
Opcode Systems, Inc.
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• Phase Invert
Phase Invert events control the status 
of the chosen audio channel’s phase 
invert button.
These events can have Off or On val-
ues. When set to off, the audio 
channel’s phase invert button is out. 
When set to on, the audio channel’s 
phase invert button is in.
For information about the function of 
the phase invert button, see page 55 
in your Audio Reference Manual.

• EQ Enable
EQ Enable events control the On/
Off status of the selected audio chan-
nel’s EQ, so their values can be On or 
Off. When set to On, the audio chan-
nel’s EQ toggle button is in. When set 
to Off, the audio channel’s EQ toggle 
button is out.

EQ Enable Off events override EQ 
Band Enable events. In order for an 
individual EQ band to be heard, both 
its toggle and the main toggle must 
be on. However, writing an EQ 
Enable Off event does not actually 
write EQ Band Enable Off events 
for the EQ bands; it simply overrides 
the current setting for each band.

EQ Enable events control this button

EQ Band (1 and 2) Enable events control
these buttons
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EQ Band Parameters

Each of the five EQ band parameters can 
be applied to each of the four EQ bands 
discretely. The types of EQ band parame-
ters are:

• Frequency
Controls the frequency of the speci-
fied EQ band. Values can range from 
20.00 Hz to 20000.00 Hz.

• Gain
Controls the gain of the specified EQ 
band. Values can range from -
18.00 dB to +18.00 dB.

• Width
Controls the width of the specified 
EQ band. Values can range from 0 to 
4.00 octaves.

• Type
Allows you to change the EQ type for 
the specified band. Clicking on the 
EQ Type setting opens a pop-up 
menu with all five EQ types.

For an explanation of the various EQ 
types, see page 71 in your Audio Ref-
erence Manual.
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• Enable
Enables and disables the chosen EQ 
band. EQ Band Enable events can 
have values of Off and On.

Each of these EQ Band Parameters can 
be written for any EQ Band, regardless of 
the band’s type. However, it is important 
to recognize that not all parameters can 
actually effect each EQ type. EQ types can 
be effected as follows:

Low and High Cut

Low Cut and High Cut cannot be 
effected by the Gain or Width parame-
ters. In the EQ Edit Window, bands 
assigned to either of these types do not 
have Gain or Width sliders.

Low and High Shelf

Low Shelf and High Shelf cannot be 
effected by the Width parameter. In the 
EQ Edit Window, bands assigned to 
either of these types do not have a Width 
slider.
19
Parametric

The Parametric EQ type can be effected 
by all parameter types. In the EQ Edit 
Window, parametric EQ bands have all 
three possible sliders.

NOTE: All EQ bands, regardless of their 
type, can be effected by EQ Band Type, EQ 
Band Enable, and EQ Band Frequency 
events.

Plug-In Parameters

The Plug-in Parameter submenu lists 
all plug-ins that are assigned (to any audio 
channel) in the sequence. For example:

Figure 1.24: Source of Plug-in Parameter submenu

...then the Plug-in Parameter
submenu looks like this.

If the Console looks like this...
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After you select a plug-in in the List 
window or Strip Chart, another pop-up 
menu appears to the right. This menu dis-
plays the selected plug-in’s parameters. 
For example, if you select opECHO, you 
might see the following (in the List 
window):

“Dry/Wet” is the default parameter 
because it is the first parameter of the 
selected plug-in. Clicking on “Dry/Wet” 
will produce a pop-up menu that contains 
the selected plug-in’s parameters.

Figure 1.25: Plug-in parameter event in the List 
Window

Figure 1.26: Plug-in parameters in the Strip Chart
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If you open the opECHO plug-in edit win-
dow, you will see that the parameters 
listed in the pop-up menu correspond to 
the parameters of the opECHO plug-in.

Figure 1.27: opECHO plug-in edit window

Vision can automate up to 1024 parame-
ters per VST plug-in.

Moving (and Copying) Plug-In 
Automation Data Between Sequences

Plug-in automation data can be copied 
from one Vision file to another as long as 
the specified plug-in is in both files. Plug-
in automation data can also be copied to a 
new file if. the specified plug-in is in your 
Vision Setup file. To include a plug-in in 
your Vision Setup file, simply assign the 
plug-in to the appropriate audio channel 
(in a Console) and choose File>Save as 
Setup. For more information about the 
Vision Setup file, see your MIDI Reference 
Manual.

Plug-in
parameters
20



 

Plug-In Parameter Values

All plug-in parameters, regardless of their 
ranges in the plug-in edit window, will 
have values between 0.0000 and 100.0000 
in the List window. The plug-in parame-
ter’s range of possible values in the plug-
in edit window is mapped onto this scale. 
When the plug-in parameter automation 
events are played back, they are mapped 
back to the appropriate range of values in 
the plug-in edit window.

For example, the opECHO Feedback 
parameter can have values ranging from 
0.000000 to 1.000000. A value of 0.696067 
in the opECHO edit window corresponds 
to a value of 69.6067 in the List window.

This system can be confusing for parame-
ters with other value ranges. For 
example, the opECHO Rhythm parameter 
uses a note size as its setting. If you 
record a value of 5/16, the list window dis-
plays 55.6818. During playback, this is 
mapped correctly back to the original 5/
16 value, but the value is hard to under-
stand in the List window. In this case, it’s 
probably best to either record your data 
real-time or draw it in the Strip Chart 
rather than inserting events in the List 
window.

Plug-In Parameter Names

Figure 1.28 shows the plug-in edit window 
for opRING, which is a “faceless” plug-in. 
Faceless plug-ins have very simple user 
interfaces. The names of parameters for 
faceless plug-ins are shown in the List 
Window and the Strip Chart.
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Figure 1.28: opRING plug-in edit window

Figure 1.29 shows the plug-in edit window 
for fusion: VINYL, a “faced” plug-in. 
Faced plug-ins have much visually cus-
tomized user interfaces.

Figure 1.29: Fusion: VINYL plug-in edit window

Names of parameters for faced plug-ins 
are not shown in the List Window or Strip 
Chart. Instead, parameters for these plug-
ins are referred to by number. All avail-
able parameters, from 1 to 1024, are 
accessible.
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In addition, the Copy Faders command 
includes values for all 1024 parameters of 
any faced plug-ins. Of course, you can 
delete the values for any parameters that 
are not actually in use by the specified 
plug-in. Parameters that are not in use 
usually have values of 0.

Using the Same Plug-In Multiple Times

A single plug-in can be used more than 
once (in the same sequence file). Its 
appearance in the Plug-in Parameter sub-
menu varies depending on how it is used.

Figure 1.30: Source of Plug-in Parameter submenu

Both the opALIGN and opECHO plug-ins 
are used twice in this configuration.

OpALIGN is used twice in the same audio 
channel, so its two separate instantiations 
are given two different names: opALIGN 
#1 and opALIGN #2. OpALIGN #1 refers 
to the lowest-numbered “slot” where 
opALIGN is used. In this case, opALIGN 

...then the Plug-in Parameter
submenu looks like this.

If the Console looks like this...
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#1 applies to the first plug-in assigned to 
Audio-1 and opALIGN #2 applies to the 
third plug-in assigned to Audio-1.

OpECHO is used once on each of the two 
audio channels, so the two separate 
instantiations are not given different 
names.

MIDI

MIDI Controller Data

All 128 MIDI Controllers can be auto-
mated, just as they could in previous 
versions of Vision. MIDI Controllers, like 
other automation parameters, are usually 
controlled using the Faders or Console 
window.

For more information about MIDI Con-
trollers, see your MIDI Reference Manual.

Other MIDI Events

Velocity scale, pitch bend, aftertouch, and 
poly aftertouch can also be automated. 
For more information about these events, 
see your MIDI Reference Manual.
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CHAPTER 3: ReWire
Vision now includes ReWire support. This 
powerful feature allows audio signals 
from ReWire compatible applications to 
be routed directly through Vision’s con-
soles, providing the same sends, plug-ins, 
and EQs you have access to with any 
other audio signal in Vision.

WHO SHOULD READ THIS 
CHAPTER?

This chapter applies to Acadia users with 
ReWire-compatible applications.
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ABOUT REWIRE

Vision’s implementation of ReWire allows 
three very important functions.

• Audio Streaming
ReWire allows up to 64 channels of 
audio to be routed (real-time) from 
one application to another.

• Sample Accurate Synchronization
After Vision and your ReWire-compat-
ible soft synth detect each other, 
sample-accurate sync happens 
automatically. 

• Transport Functionality
The transport controls of all ReWire 
compatible applications in your 
system are automatically linked. You 
can press play, stop, etc. in any appli-
cation and all will perform in sync.
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CONFIGURING YOUR SYSTEM 
FOR REWIRE

Follow these simple steps to configure 
your system to work with ReWire.

a Put the ReWire extension in your 
System Folder>Extensions folder.

b Install a ReWire compatible 
application for use with Vision.

This could include ReBirth, a ReWire 
compatible software synthesizer, or any 
other ReWire compatible application.

See the following sections for examples 
of how to use Vision with Rebirth and 
Retro AS-1 via ReWire.

c Allocate more RAM to Vision.

ReWire requires that additional memory 
be allocated to Vision before it is 
launched. Vision may crash or hang if it 
doesn't have enough memory to load 
when launched with ReWire installed. 
With several VST plug-ins in your plug-
ins folder, allocating 30,000 to 35,000K 
for Vision is usually sufficient. 

To increase the amount of allocated 
memory, quit Vision (if it is open) and 
single-click on its icon in the Finder. 
Choose File>Get Info and enter a higher 
number into the Preferred Size field (in 
the Memory section of the Window). 
Close the window and launch Vision 
again.
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For more information about RAM and 
Acadia mode, see page 86 in your 
Audio Reference Manual.

After launching Vision, open the Audio 
Instruments window. Scroll to the bottom 
of the window. Following the Instru-
ments, Inputs, Outputs, and Busses 
sections is a fifth section for your ReWire 
compatible application(s).
d Enable the ReWire channels you want 

to use in Vision.

For more information about enabling 
inputs and outputs in Acadia mode, see 
page 39 in your Audio Reference 
Manual.

NOTE: Enabled inputs and outputs con-
sume valuable CPU resources. 
Therefore, to preserve CPU resources, 
enable only the inputs you plan to use.
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EXAMPLE 1: USING VISION 
WITH REBIRTH

When using Vision and ReBirth together 
via ReWire, the two applications are auto-
matically synced. ReWire takes care of 
this for you; you don’t need to set Vision 
or ReBirth to send or receive MIDI Beat 
Clock or MIDI Time Code when working 
with ReWire. All necessary information is 
transmitted via the ReWire extension.

ReBirth 2.01 is recommended when using 
the ReWire extension with Vision 4.5. 
Also, as previously discussed, make sure 
that you have enough memory allocated 
to Vision.

a Launch Vision.

For ReWire to work properly, Vision 
must be launched before Rebirth.

b Under Options>Sync Options, put a 
check next to Remote Start.

This will enable you to play and stop 
Vision from ReBirthÕs transport controls. 
You can control ReBirth from VisionÕs 
transport controls even if Remote Start 
is not checked.

VisionÕs play button begins to flash.

c Launch ReBirth.

Open the ReBirth file that you wish to 
work with, or begin a new file.
25
d In Vision, choose Windows>Audio 
Instruments.

Scroll to the bottom of the window, and 
you will see something like this:

Enable any ReBirth channels (inputs) 
you wish to use. Remember, each 
enabled input requires RAM, so itÕs best 
to enable only the inputs you plan on 
using. These inputs usually correspond 
to the ReBirth sounds you are using.

e Open a Console.

f Choose Build Console From>Enabled 
ReWire Channels from the Console 
window pop-up menu.
Opcode Systems, Inc.
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g Press Play in either Vision or ReBirth.

Vision and ReBirth begin to play in sync.

h Look at the Console you set up in 
step 7.

ReBirthÕs audio appears in the appropri-
ate Console channels.

i While listening to the song, set up 
your mix and assign any sends, plug-
ins, EQs, etc., that youÕd like.

Launching Vision and ReBirth

It's important to launch Vision before 
launching ReBirth 2.0 (or higher) with 
ReWire installed. If you launch the appli-
cations in the incorrect order, you’ll see 
this dialog:
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If this dialog appears, quit both applica-
tions and then launch them in the correct 
order.

Quitting Vision and ReBirth

Vision cannot be quit while ReBirth is 
open when using the ReWire Extension.

If you try to quit Vision while ReBirth is 
open, the following error message will 
appear:

Click the OK button and then quit 
ReBirth before quitting Vision.
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EXAMPLE 2: USING VISION 
WITH RETRO AS-1

Using Vision with Retro is somewhat dif-
ferent than using Vision with ReBirth, 
because Retro is a software synthesizer 
that must be triggered with MIDI. To trig-
ger Retro with MIDI, you must have the 
Retro AS-1 OMS Driver in your System 
Folder>OMS Folder.

After installing the Retro OMS driver, 
choose Studio>MIDI Cards and Inter-
faces in OMS, which will update your 
OMS setup to include Retro AS-1. 

After Retro AS-1 is included in your OMS 
Studio Setup, save your setup and go to 
Windows>Instruments in Vision. Open 
the Instruments Window popup menu and 
choose Make from Studio Setup. Click 
Make to include Retro in your list of 
MIDI instruments.

For more information about configuring 
Retro AS-1 with OMS, please see your 
Retro AS-1 manual.

The following example shows how to use 
Retro with Vision via ReWire (when Retro 
is installed and configured in OMS).
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a In Retro AS-1Õs control panel, select 
Plug-In from the Audio Output pop-up 
menu.

Figure 2.1: Retro Control Panel

Selecting Plug-In enables RetroÕs out-
puts to work with ReWire. If any other 
option is selected in this pop-up, 
Retro AS-1Õs audio output will not be 
routed through Vision.

Plug-In does not refer specifically to 
VST plug-ins; you must choose this 
option whether or not you plan to use 
VST plug-ins.

b In Vision, assign your MIDI tracks to 
Retro instruments.

In this example, weÕre assuming that you 
already have MIDI notes assigned to 
Retro AS-1.
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c Open the Audio Instruments window, 
and scroll to the bottom to see your 
Retro inputs.

Enable any Retro channels you wish to 
use. These inputs should match the 
Retro MIDI channels that youÕre using (in 
step 1).

Remember, each enabled input requires 
RAM, so itÕs best to enable only the 
inputs you plan on using.

d Open a Console.

e Choose Build Console From>Enabled 
ReWire Channels from the Console 
window pop-up menu.
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f Press Play, and youÕll hear your MIDI 
tracks.

g Look at the Console you set up in 
step 4.

RetroÕs audio appears in the appropriate 
Console channels.

h While listening, set up your mix and 
assign any sends, plug-ins, EQs, etc., 
that youÕd like.

Setting Retro AS-1’s Audio 
Output

If Retro’s Audio Output is set to some-
thing other than Plug-in when you 
launch Vision (with ReWire installed), 
you will see this dialog box.

See step 1 on page 27 for an explanation.
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ADDITIONAL REWIRE NOTES

ReWire Inputs

ReWire channels are referred to as 
“inputs” in Vision. An audio signal “out-
put” in another application (like ReBirth) 
is sent via ReWire to an input in Vision.

For documentation purposes, “input” and 
“channel” are synonymous when discuss-
ing ReWire.

Enabled ReWire Channels in the 
Audio Instruments Window

By default, the only enabled ReBirth or 
Retro input (in the Audio Instruments 
window) is the “Mix” (or “Main”) input. 
The Mix input includes all audio from the 
application. Other ReWire applications 
may or may not have a “Mix” channel; it is 
up to the manufacturer to decide.

You can also enable individual ReWire 
inputs. This is useful if you want to mix 
each channel separately, but it does 
require more RAM.

NOTE for ReBirth Users: In addition to 
individual inputs and a general Mix input, 
ReBirth also includes an 808 Mix and a 
909 Mix input.

If you enable an individual input while the 
“Mix” input is enabled, you may hear the 
individual channel on its own input and 
the Mix input. This could cause an unde-
sirable “doubling” effect. However, 
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ReBirth and Retro automatically remove 
all enabled individual inputs from the Mix 
input. Other ReWire applications may 
behave differently; again, it is up to the 
manufacturer to decide.

For example, if Retro AS-1 Main and 
Retro AS-1 Ch 1 are enabled, the 
Retro AS-1 Main input will contain only 
the signal from Retro channels 2-15.

Enabling and Disabling ReWire 
Channels

You cannot enable or disable ReWire 
channels while playing. If you need to 
enable or diable a ReWire channel, stop 
playback before making the change.

Mono/Stereo Status of ReWire 
Channels

You cannot change ReWire channels’ 
mono/stereo status. Each channel’s 
mono/stereo status is determined by the 
manufacturer and cannot be modified.

ReWire and Synchronization

When the ReWire extension is located in 
the System Folder>Extensions Folder, 
Vision’s Send Sync option does not need 
to be enabled to sync Vision with other 
ReWire compatible applications. All 
required synchronization information is 
communicated between applications via 
the ReWire extension.
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However, if you wish to control Vision 
from the transport controls of another 
application (such as ReBirth), you must 
check Remote Start under Options>Sync 
Options.

When Remote Start is checked, Vision’s 
play or record button starts to flash, indi-
cating that it can be controlled from an 
external source. For more information 
about Remote Start, see your MIDI Refer-
ence Manual.

Active in Background

Active in Background is required when 
using Vision with ReBirth via ReWire, and 
it is automatically checked whenever the 
“ReBirth Engine” extension is enabled.
Vision & Studio Vision Pro - What’s New in 4.5
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CHAPTER 4: File Management Changes
VIEWING THE FILE PATH

To see the entire file path of an audio file, 
hold down the Command key and click on 
the file. You can command- click any-
where on the waveform or the file name.

PLAYING AUDIO FILES

NOTE: This feature is only available in 
Acadia mode. DAE does not support play-
back in the File Management window.

Audio files can now be played directly 
from the File Management window. To 
play an audio file in the File Management 
window:

a Select the file you wish to play (by 
clicking on it).

b Click the Play button.
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Listen to the audio file. A small vertical 
line follows playback in the audio 
waveform.

c When you are finished, click the Stop 
button.

You can also make playback skip to a dif-
ferent point in the audio file by clicking 
where you’d like playback to continue.
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FILE MANAGEMENT MENU

Label

Label allows you to apply one of the 
Finder’s labels to the file. If a single file is 
selected when you choose the Label com-
mand, the following dialog box appears.

Figure 2.2: Label dialog box with a single file 
selected

A File name: The name of the file is 
displayed here. This information is 
read-only; the file’s name cannot be 
changed in this window. For informa-
tion about renaming audio files from 
the File Management window, see 
Rename (pg. 39).

A

B

C
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B Label: The file’s current label is dis-
played here. Click on the label popup 
to see the your options:

Figure 2.3: Label Pop-up

The options in the Label popup echo 
the Finder’s Label options. Choosing 
a Label here will label the file in the 
Finder.

C Comments: The file’s current com-
ments are displayed in this field. You 
can also type here to add comments 
to the file in the Finder’s Get Info 
window.
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If more than one file is selected when the 
Label command is chosen, the dialog box 
looks like this.

Figure 2.4: Label dialog box with more than one 
file selected

A If the file doesn’t already have a 
label: If the file does not yet have a 
label in the Finder, it will be given the 
label assigned here. This pop-up is 
the same as the one shown in 
Figure 2.3.

A

B
C

D
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B If the file already has a label:

If the file already has a label, its label 
will either experience no change or 
be changed to the label selected in 
this pop-up (as specified).

C Replace/Append:

This pop-up refers to the file’s com-
ments. Selecting Replace will delete 
the old comments for all selected files 
and replace them with the comments 
typed in this window. Append will 
add the comments typed in this 
window to the comments already 
associated with the file.

D Comments: Type in this field to add 
comments to the file in the Finder. 
How these comments are treated is 
affected by the Replace/Append 
setting.

It can become very difficult to keep track 
of audio files that are used in multiple 
sequences. The following example shows 
how to use the Label command to help 
keep track of your files.
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Example: Labeling Files

Imagine you have a folder that has many 
audio files and three Vision documents, 
each referring to several of the audio files. 
Some audio files are used by one, two, or 
three sequence files, and some are not 
used. No files have labels or comments, 
and you need a way to easily distinguish 
which audio files are used by which 
sequences.

a Open the first sequence file.

b Go to the File Management window 
and choose ÒSelect AllÓ from the pop-
up menu.

c Choose ÒLabelÓ from the pop-up 
menu.

Make the following settings.

d Click OK.

Now all the files used by the first 
sequence are orange in the finder.

e Open the second sequence file.
Vision & Studio Vision Pro - What’s New in 4.5
f Repeat steps 2-4 with the following 
settings.

Now the files used only by the first 
sequence are orange, the files used only 
by the second sequence are brown, and 
the files used by both sequences are 
red.

g Open the third sequence file.

h Repeat steps 2-4 with the third 
sequence file, making the following 
settings

.

Now the files used only by the first 
sequence are orange, the files used only 
by the second sequence are brown, and 
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the files used only by the third sequence 
are blue. All files used by more than one 
sequence are red. 

i In the Finder, select a red file and 
choose File>Get Info.

You might see the following.

The Comments field tells you exactly 
which sequences use the file.

In addition, if a file is not used in any 
sequence, it will appear with no label.

Copy to Folder

Copy to Folder puts a copy of the 
selected audio file(s) into the specified 
folder. Like the Copy command in the 
Finder, Copy to Folder leaves the origi-
nal files untouched.

The Copy to Folder command can be 
used to easily “round up” all of the files 
used in a sequence and put them in one 
folder.

If one file is selected, you will see the 
following.
35
Figure 2.5: Copy to Folder dialog box

Provided that there is enough space on 
the selected volume and there are no files 
with the same name in the destination 
folder, the selected files will be copied. 
You will then see a dialog prompting you 
to replace all audio event references to 
the original file with references to the new 
file.

Clicking Replace will change the 
sequence’s audio event references so that 
they point to the new (copied) file. Click-
ing Cancel will leave them untouched.

The process is slightly different if you 
select more than one file. First you will be 
prompted with the dialog box shown in 
Figure 2.5. Then Vision asks you whether 
or not you want to replace event refer-
ences for each of the files you copied 
(individually).
Opcode Systems, Inc.
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For the first file, the dialog looks like this.

Click Replace to change the sequence’s 
references to that (single) audio file so 
that they point to the new (copied) file. 
Click Replace All to change the refer-
ences to all selected audio files so that 
they point to the new (copied) files. Click 
Cancel to leave references to that (sin-
gle) audio file untouched. Click Cancel 
All to leave all references untouched.

If you respond with Cancel or Replace, 
the references for that file are adjusted 
(or not adjusted) as you specified. A simi-
lar dialog box, referring to the next file on 
the list, appears.

Figure 2.6: Copy to Folder dialog box

Click Replace to change the sequence’s 
references to that (single) audio file so 
that they point to the new (copied) file. 
Click Replace Remaining to change the 
references to all remaining selected audio 
files so that they point to the new (copied) 
Vision & Studio Vision Pro - What’s New in 4.5
files. Click Cancel to leave references to 
that (single) audio file untouched. Click 
Cancel Remaining to leave all refer-
ences to remaining selected files 
untouched.

NOTE: Once you respond to the dialog box 
for a specific file, that file’s references are 
updated immediately. The file will not be 
affected by choosing Replace Remaining 
or Cancel Remaining in subsequent dia-
logs. Replace Remaining or Cancel 
Remaining affect only the currently listed 
audio file and all files that have not yet 
been referred to specifically.

Each file will show the dialog box in 
Figure 2.6 until you reach the last 
selected file in the list. At that point the 
dialog box looks like this.

Click Cancel to leave references to the 
audio file untouched.Click Replace to 
change the sequence’s references to the 
audio file so that they point to the new 
(copied) file.

Tip for Using Copy to Folder

After using the Copy to Folder com-
mand, your File Management window will 
contain twice the number of audio files it 
did before using the command.
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Figure 2.7: File Management window before using 
Copy to Folder

Figure 2.8: File Management window after using 
Copy to Folder

The number of files has doubled because 
the window includes the original files and 
the newly copied files. In most cases, this 
is undesirable from an organizational 
standpoint.
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You can easily “clean up” the File Man-
agement window by choosing Select 
Unused followed by Remove from List 
(both in the File Management window 
menu).

Choose Select Unused, and any audio 
files which are not referenced by the cur-
rent sequence file are selected.

Figure 2.9: After choosing Select Unused

Choose Remove from List, and those files 
are removed from the File Management 
window.

Figure 2.10: After choosing Remove from List

For more information about Select 
Unused, see page 299 in your Audio Ref-
erence Manual. For more information 
about Remove from List, see page 299 in 
your Audio Reference Manual.
Opcode Systems, Inc.
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Move to Folder

Move to Folder moves the selected 
audio file(s) into the specified folder. 
Unlike Copy to Folder, Move to Folder 
does affect the original files.

Move to Folder automatically updates all 
references to the audio file so that they 
point to the file in its new location.

After selecting one or more audio files 
and choosing Move to Folder, the follow-
ing dialog box appears.

If all the selected files and the destination 
folder are on the same volume, the files 
are moved to the selected folder.

You cannot move files across volumes. 
This is a function of the Macintosh operat-
ing system. If you select a folder on a 
different volume when using Move to 
Folder, you will be prompted with the fol-
lowing dialog.
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Click Cancel to abandon the procedure. 
Click OK to copy the file(s) to the 
selected folder. After the copy procedure 
is complete, you will be prompted to 
replace references to the original file with 
references to the new file. See Copy to 
Folder (pg. 35) for details.

After using Copy to Folder or Move to 
Folder, you may want to command-click 
on the file name to see the entire file path 
(for verification). See page 31 for details.
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Rename

The Rename command changes the 
name(s) of the selected audio file(s) in 
the Finder, as well as in the File Manage-
ment window.

The name of the file(s) will be changed, 
but files remain in the same folder. All ref-
erences in the sequence are updated to 
refer to the file’s new name.

If only one file is selected when you 
choose Rename, you will see the follow-
ing dialog box.

Type the new name for the file. The name 
is updated in the File Management 
window (as shown in Figure 2.11). The 
name of the file is also updated in the 
Finder.

Figure 2.11: “Flashy Loop” in File Management
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If you select more than one file before 
choosing Rename, you will see the 
following.

The file’s new name can be typed into this 
dialog box.

Click Cancel All to leave the names of all 
selected files untouched. Click Cancel to 
leave the name of the current file (the file 
named in the dialog box) untouched, but 
proceed to the next file for renaming. 
Click OK to update the name of the file in 
both the Finder and the File Management 
window and proceed to the next file.

If you click Cancel or OK, you will see this 
dialog box.

Click Cancel Remaining to leave the 
names of this file and all remaining 
selected files untouched. Click Cancel to 
leave the name of the current file (the file 
named in the dialog box) untouched, but 
proceed to the next file for renaming. 
Opcode Systems, Inc.
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Click OK to update the name of the file in 
both the Finder and the File Management 
window and proceed to the next file.

NOTE: Remember, once you respond to the 
dialog box for a specific file, that file’s name 
is updated immediately. The file will not be 
affected by choosing Cancel Remaining in 
subsequent dialogs. Cancel Remaining 
affects only the currently listed audio file 
and all files that have not yet been referred 
to specifically.

All files will show the dialog box in 
Figure 2.12 until you reach the last 
selected file in the list. At that point the 
dialog box looks like this.

Figure 2.12: Rename dialog box

Click Cancel to leave the name of the cur-
rent file untouched. Click OK to update 
the name of the file in both the Finder and 
the File Management window.

Figure 2.13: File names updated in the File 
Management window
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Find File

Normally, if you rename an audio file or 
move it to a new location, Vision is smart 
enough to find it. But if an audio file gets 
lost for some reason, choose Find File to 
display a dialog box asking you to locate 
the missing audio file. 

Once you locate a lost audio file, you must 
save the Vision file to update its pointer to 
the audio file’s new name or location.

If you cancel the Find File dialog box, the 
Vision file won’t update its pointer to the 
audio file and you’ll be asked to find it 
each time you open the sequence file.

In previous versions of Vision Find File 
was called Where Is.
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CHAPTER 5: Strip Silence and Slice Audio
The Strip Silence command and dialog 
box includes a new option called Slice 
Audio.

SLICE AUDIO

Vision can automatically separate digital 
audio into useful regions using the Slice 
Audio command. When Vision “sepa-
rates” audio, it breaks a long audio file 
into several small events based on the cri-
teria in the Strip Silence dialog box. This 
is useful for several reasons: 

• You can easily copy and paste small 
sections of audio (such as a particular 
drum sound, or an oft-repeated vocal 
line).

• You can quantize individual events 
(such as separate drum hits in a 
recorded drum track) to be used as 
samples.

• If you’re syncing to tape and are play-
ing back digital audio using only the 
session sample rate, breaking audio 
into smaller events means there is 
less likelihood of digital audio drifting 
“out of sync” with audio on tape.

To auto-separate, select Slice Audio in the 
Slice Audio/Strip Silence pop-up menu.
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AUTO-SEPARATING WITH SLICE 
AUDIO

The Slice Audio command can be used to 
separate one long audio event into several 
short events (based on the silence in the 
audio file).

To slice audio, first determine what ampli-
tude level should trigger the beginning of 
an event. Then, determine how long the 
amplitude must stay below this level for a 
new event to be generated. Finally, deter-
mine the desired attack time for the new 
events.

To auto-separate an audio event:

a Make sure either ÒFastÓ or ÒHigh 
ResolutionÓ is checked in the 
Audio>Waveform Display 
submenu.

The Slice Audio procedure will not func-
tion if the waveform display is turned off.
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b Select the desired event(s) or range of 
events you wish to affect.

In this example, weÕve selected a vocal 
part. WeÕll split this part into individual 
words.

Figure 2.14: Audio before slicing

c Choose Audio>Strip Silence/Slice 
Audio.

Vision opens the Strip Silence dialog 
box.

Figure 2.15: Strip Silence Dialog Box

d Set the desired Slice Audio 
parameters.

Make sure that Slice Audio is selected in 
the pop-up menu.

The Strip Silence dialog box is discussed 
in detail in Strip Silence Dialog Box 
(pg. 43).
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e Click the Slice Audio button.

Vision ÒslicesÓ the audio into several 
small pieces.

Figure 2.16: Audio after slicing

f Audition the audio ÒslicesÓ.

To audition an individual slice, first select 
the slice you want to hear.

Then, press option-spacebar (�+ú) 
to hear your selection.

If youÕre not happy with the results, 
choose Edit>Undo Slice Audio and use 
a different set of Slice Audio parameters.

When the audio signal goes above the 
threshold, Vision begins a new event. As 
soon as “silence” (as defined in the Strip 
Silence dialog box) is recognized, Vision 
waits for the next point when the audio’s 
volume goes above the threshold. At that 
point, the first event ends and another 
event begins.

IMPORTANT NOTE: Slice Audio will 
strip any silence at the beginning of the 
selected audio away. Compare Figure 2.14 
on page 42 and Figure 2.16 on page 42 to 
see an example.
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STRIP SILENCE VS. SLICE 
AUDIO

Try making some settings in the Strip 
Silence dialog box and applying them to 
an audio file with Strip Silence selected in 
the pop-up menu.

Then choose Edit>Unde Strip Silence and 
select Slice Audio in the Strip Silence pop-
up menu. Don’t change any other set-
tings; click Slice Audio.

You should see results like these:

Figure 2.17: Using Strip Silence and Slice Audio

As you can see, slicing audio results in the 
same beginning points for events, but 
each event continues until the beginning 
of the following event. When stripping 
silence, each audio event ends as soon as 
its volume falls below the silence 
threshold.

Starting with one long event like this...

...gives this result if Strip Silence is chosen...

...or this result if Slice Audio is chosen.
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STRIP SILENCE DIALOG BOX

When you select one or more audio 
events and choose Audio>Strip Silence/
Slice Audio, Vision opens the Strip 
Silence dialog box.

Figure 2.18: Strip Silence Dialog Box

As can be seen in Figure 2.18, the Strip 
Silence dialog box contains many ele-
ments. These are discussed in the 
following sections.

Silence Threshold

Use the Silence Threshold numerical to 
set the “noise floor” for the Strip Silence/
Slice Audio operation (in decibels). You 
can set this number between -96 dB and 0 
dB.

When using Strip Silence, values close to 
-96 dB will strip away very little if any 
audio, since even the slightest amount of 
noise will be above the noise floor. Values 
close to 0 dB will strip away nearly all of 
the audio. Generally, a value between 
-40 dB and -20 dB is appropriate for most 
applications.
Opcode Systems, Inc.
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When using Slice Audio, values close to 
0 dB or -96 dB will generate few events. In 
most cases, values between -40 dB and 
-20 dB will generate many short events.

As shown in Figure 2.19, when you 
change the Silence Threshold, Vision 
illustrates it graphically in the audio wave-
form display.

Figure 2.19: Graphic Feedback of Threshold Level

As an experiment, enter a different value 
in the Silence Threshold numerical and 
preview the effect in the Graphic Win-
dow’s waveform display. Feel free to 
experiment with different thresholds. 
Once you gate or auto-separate audio with 
the Strip Silence/Slice Audio com-
mand, you can audition it—if you’re not 
happy with the results, undo the com-
mand and try a different Threshold Level.

2. Audio that stays in this region for at

least the amount of time specified by the

Minimum Duration parameter will be silenced.

1. A Silence Threshold of -12 dB is indicated

graphically by the horizontal lines in the

Graphic WindowÕs waveform display.
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Minimum Duration

Besides setting a threshold level, you 
must also tell Vision how long a signal 
must remain below that threshold before 
stripping it away or allowing the genera-
tion of a new event. Use the Minimum 
Duration numerical to set the amount of 
time the signal must stay below the 
threshold level before it’s recognized as 
silence. You can set this number between 
10ms and 1,000ms.

When working with Strip Silence, long 
settings will strip areas between phrases, 
but not the brief pauses between words or 
drum beats (for example). Short settings 
will strip areas between words or even syl-
lables. Of course Slice Audio will not strip 
away the silence, but it will generate a 
similar number of events. Values around 
100 milliseconds make a good starting 
point.

As shown in Figure 2.20, setting a smaller 
duration results in more (but shorter) 
audio events than setting a longer 
duration.
anual 44



PART 6: Advanced Audio Techniques
Figure 2.20: Effect of Different Minimum Duration 
Settings

Feel free to experiment with different 
minimum durations. Once you gate or 
auto-separate audio with the Strip 
Silence/Slice Audio command, you can 
audition it—if you’re not happy with the 
results, undo the command and try a dif-
ferent Minimum Duration.

2. Stripping with 1/2 sec minimum duration

3. Stripping with 1/10 sec minimum duration

1. Original audio event

(all other parameters equal)
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Attack Time

Use the Attack Time numerical to set the 
amount of time it takes for the audio 
signal immediately following a stripped 
section to regain its full volume. Allowable 
values are between 0 ms and 1,000 ms (1 
second). The length of the attack time 
you choose will depend on the sonic char-
acteristics of your audio file (for example, 
you would probably want to use a short 
value with a drum track due to the short 
attack most percussion sounds have).

Setting an attack time can make the after-
effects of strip silencing sound more natu-
ral. In a similar way, it can make audio 
slices sound more natural when played 
individually (not in the context of the sur-
rounding slices).

With both Strip Silence and Slice 
Audio, Attack Time determines when 
each event will begin. The Attack Time 
(in milliseconds) is subtracted from the 
moment that the audio signal crosses the 
Silence Threshold to set the beginning 
point of the event. With a longer Attack 
Time, the separation will occur long 
before the audio signal crosses the 
threshold.

Feel free to experiment with different 
attack times. Once you gate or auto-sepa-
rate audio with the Strip Silence/Slice 
Audio command, you can audition it—if 
you’re not happy with the results, undo 
the command and try a different Attack 
Time. For an example of how to use the 
Attack Time parameter, see Attack Time 
Example (pg. 46).
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Release Time

Use the Release Time numerical to set 
the amount of time it takes for the audio 
signal immediately preceding a stripped 
section to fade out. As with the Attack 
Time numerical, setting a release time 
can often sound more natural than an 
instantaneous change in volume. The 
length of the release time you choose will 
depend on the sonic characteristics of 
your audio file. Allowable values are 
between 0 ms and 1,000 ms (1 second).

Feel free to experiment with different 
release times. Once you gate audio with 
the Strip Silence command, you can 
audition it—if you’re not happy with the 
results, undo the Strip Silence command 
and try using a different Release Time. 
For an example of how to use the Release 
Time parameter, see Attack Time Exam-
ple (pg. 46).

Release Time is not available (grayed 
out) when working with Slice Audio. 
Slice Audio is much like as Strip 
Silence with an infinite release time. 
When silence is detected, the current 
event continues all the way to the begin-
ning of the next event or to the end of the 
original event (the event selected before 
choosing Strip Silence/Slice Audio).
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ATTACK TIME EXAMPLE

In following example, we’ve used Strip 
Silence with a Silence Threshold of -20 dB 
and Minimum Duration of 100 ms.

After stripping the silence, we are left with 
two separate audio events, as show in 
Figure 2.21.

Figure 2.21: Strip Silence Events

As seen in Figure 2.21, the first audio 
event cuts off too early and the second 
audio event starts too abruptly.

This portion of the
signal is below the
silence threshold and
longer than the
minimum silence. It
will be stripped.

This portion of the
signal is below the
silence threshold but
shorter than the
minimum silence. It
will not be stripped.

These portions of the signal are above
the silence threshold. They will not be stripped.

Abrupt cut-offs due to Strip Silence
anual 46



PART 6: Advanced Audio Techniques
We can correct this problem by using a 
Release Time of 100 ms and an Attack 
Time of 20 ms. With these settings, the 
events from the Strip Silence command 
will have more gradual attack and release 
times (see Figure 2.22).

Figure 2.22: Strip Silence Events

Setting Attack (and Release) times can 
result in more natural-sounding events 
when you use the Strip Silence and 
Slice Audio commands.

USE ZERO CROSSINGS

The Use Zero Crossings option, available 
in earlier versions of Vision, no longer 
exists. Vision always uses zero crossings 
with all applicable audio commands.

Automatically using zero crossings conve-
niently avoids pops and clicks at the 
beginnings and ends of audio events.

Natural sounding cut-offs
due to Attack and Release settings

An extra 20 ms was
left at the beginning
of this event

An extra 100 ms was
left at the end of
this event
47
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MAXIMUM FADER POSITION

The Maximum Loudness setting (under 
Audio>Audio Preferences) has been 
changed to Maximum Fader Position.

In previous versions, audio volumes were 
displayed as values from 0 to 127, with 
each numeric value corresponding to a 
decibel value. The Maximum Loudness 
setting was used to determine how these 
values were mapped (see your Vision 4.1 
Manual Supplement for details).
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Audio volumes are now displayed in deci-
bels, so there is no need for this mapping. 
The new setting, Maximum Fader Posi-
tion, sets the decibel level that will result 
if an audio volume fader is dragged to its 
maximum value.

The numeric field of a Console fader 
assigned to audio volume and dragged to 
its maximum value will display the Maxi-
mum Fader Position in decibels.

The numeric field of a fader (in the 
Faders window) assigned to audio volume 
and dragged to its maximum value will 
display 127, but this number will be 
mapped to the Maximum Fader Position. 
For more information about audio volume 
faders in the Faders window, see Fader 
Values (pg. 78).

LOCK EVENT SMPTE TIMES

The old Seqs menu that appeared in the 
List window and Tracks/Pulse window 
Strip Chart for tracks with sequence 
events in them has changed.
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The menu is now called Opts, and it con-
tains an additional command that can 
apply to any track, regardless of whether 
or not the track contains sequence events. 
For that reason, the menu appears in the 
List window and Tracks/Pulse Window 
Strip Chart for all tracks.

When checked, this option locks the 
SMPTE time of each event in the track so 
that even if you change the tempo of the 
sequence, each event in the track will play 
at the appropriate SMPTE time.

This is especially useful if you are scoring 
a film and want to set up a “sound effects” 
track. Simply check Lock Event SMPTE 
Times in the Opts menu for that track, 
and you can freely change the tempi of 
the music in the sequence without affect-
ing the sound effects.

You can check Lock Event SMPTE 
Times for as many tracks in the sequence 
as you like.

Opts menu
49
REMOVAL OF SOUND 
MANAGER AND YAMAHA CBX

The Sound Manager and Yamaha CBX 
audio systems are no longer included 
with Vision or Studio Vision. However, 
you can address your computer’s Sound 
Manager hardware in Acadia audio mode 
with the Sound Manager I/O driver.

For information about Acadia, please see 
your Vision 4.1 Manual Supplement.

STRIP CHART

Graphic Window

The “newer” Strip Chart that was included 
in the Tracks and Pulse windows in ver-
sion 4.0 has been included in the Graphic 
window in version 4.5. The Strip chart has 
also been updated to allow access to the 
new automation events.

Notation Window

The Strip Chart is no longer available in 
the Notation Window.
Opcode Systems, Inc.
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VELOCITY SCALE

The feature know as “Velocity Fader” has 
undergone some changes, and it is now 
called “Velocity Scale”.

Velocity Scale in the Instrument 
Window

The Velocity Scale checkbox allows 
enabling and disabling of velocity scaling 
for a particular instrument. If the box is 
checked, velocity scale events assigned to 
the selected instrument will be followed. 
If the box is unchecked, those events will 
be ignored.

This box is particularly useful if you’ve 
been working with velocity scale and sud-
denly find that you can’t hear an 
instrument. A very low velocity scale set-
ting could cause that scenario. You can 
simply uncheck the Velocity Scale check-
box in the Instruments window to 
determine whether this is the cause of the 
problem.

The Velocity Scale % number ranges 
from 1% to 250% and controls the scaling 
of velocities for the Instrument or line.

The default value is 100% and does not 
change note velocities during playback. 
Numbers less than 100% reduce outgoing 
velocities and numbers greater than 100% 
increase them. This still affects the veloci-
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ties even if a fader is controlling them, so 
several lines can be controlled by the 
same fader, each with different scalings.

Faders from the Faders and Consoles 
Windows can be used to control velocity 
for the Instrument. A fader value of 127 
equals the full scaled velocity level. For 
example, a note recorded at a velocity 
level of 64, with Velocity Scale % set to 
50, results in a velocity level of 32 (50% of 
64) with the fader at 127. Changing the 
percentage to 150, but keeping the fader 
at 127, outputs the same note with a veloc-
ity level of 96 (150% of 64). See Using 
Faders to Control Instrument Velocities 
(pg. 80) for further information.

SETTINGS WINDOW

Real-Time: Solo Audio and MIDI 
independently

When checked, soloing of one or more 
Audio Instruments will not mute MIDI 
Instruments, and soloing of one or more 
MIDI Instruments will not mute Audio 
Instruments. Instruments can be soloed 
from the Instruments or Audio Instru-
ments window, Consoles, Plug-in edit 
windows, and EQ edit windows.

This does not apply to audio or MIDI 
tracks, however. Soloing tracks still 
behaves as it always has; if one or more 
tracks are soloed, only the soloed tracks 
can be heard (regardless of whether they 
are MIDI, audio, or multi tracks).
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If unchecked, soloing an Instrument 
(Audio or MIDI) will mute all remaining 
instruments (Audio or MIDI).

TRACKS WINDOW

Cursor Display

The Cursor Display constantly reflects 
the placement of your cursor in the track 
overview.

This is useful when you prefer more spe-
cific numeric feedback to graphical 
feedback about your cursor’s position. 
For example, when making selections, 
dragging, etc., it is often helpful to know 
exactly where your cursor is.

Clicking on the I-beam icon in the Cursor 
display (as shown in Figure 2.23) toggles 
a SMPTE display on and off.

Figure 2.23: Cursor display

The SMPTE display is especially useful 
when scoring to film or video; for 
instance, if you need to insert a sound 
effect at a specific SMPTE location, use 
the SMPTE cursor display to ensure that 
the data is entered accurately.
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REARRANGING PLUG-INS BY 
VERTICAL DRAGGING

It is now possible to re-order plug-ins by 
dragging them vertically. To do so:

a Click and hold in the Plug-In Type 
area of the plug-in you wish to move.

b Drag to the plug-inÕs desired location.

In this example weÕre moving the third 
plug-in so that it will be first.
Opcode Systems, Inc.
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c Release the mouse.

The plug-ins are rearranged.

NOTE: It is not possible to drag plug-ins to 
incompatible locations. For example, you 
cannot drag a mono plug-in to occur after a 
stereo plug-in or a mono in/stereo out plu-
gin. For more information about mono and 
stereo plug-ins, see your Audio Reference 
Manual.

When a plug-in is vertically dragged, its 
automation data remains intact. However, 
if you attempt to re-order plug-ins by reas-
signing (choosing a different plug-in), all 
automation data for the selected plug-
in(s) will be lost.
Vision & Studio Vision Pro - What’s New in 4.5e
 52



1

Features and Functions

that have Changed 2
Vision & Studio Vision Pro - What’s New in 4.5 53



CHAPTER 7: The Console Windows
Vision offers sixteen separate Console 
Windows, each of which contains 24 chan-
nels. Console Windows can be configured 
as desired to perform a number of differ-
ent functions:

• Record dynamic MIDI and Audio 
Instrument mixes (or create static 
mix “snapshots”);

• Create real-time controllers for impor-
tant synthesizer and effects 
parameters, and record those param-
eter changes as part of the sequence;

• Assign EQs and VST plug-ins to 
Audio Instruments, busses, inputs, 
and outputs and edit them (in Acadia 
audio mode). See your Audio Refer-
ence Manual for details.

• Assign TDM plug-ins to Audio Instru-
ments and edit them (only if you own 
Studio Vision Pro and a Digidesign 
TDM-equipped digital audio system). 
See your Audio Reference Manual for 
details.

ABOUT CONSOLES

Console Windows are similar to the 
Faders Window, but offer more control. 
You should understand the Faders 
Window before using Consoles.
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Like the Faders Window, the Console 
Windows control Vision’s automation 
events. The Faders Window is discussed 
in the previous chapter and automation 
events are discussed in the Automation 
chapter of your Audio Reference Manual.

In the current version of Vision, each 
fader directly controls an automation 
parameter, such as volume, pan, velocity 
scale, or any MIDI controller.

Vision can automate up to 800 different 
faders—each assigned to a different 
Instrument, channel, or MIDI control. 
Faders 1-32 are controlled from the 
Faders Window. The others are con-
trolled from the Console Windows.

OPENING A CONSOLE WINDOW

To open a Console Window:

a Press and hold the mouse over the 
Windows>Console command.

Vision produces a submenu of console 
choices.
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b Select one of the sixteen consoles 
from the submenu.

Vision opens that Console Window.

Figure 2.24: Typical Wide Console Window

BASIC CONSOLE WINDOW 
ANATOMY

Vision offers numerous display choices 
for each console, including:

• Channel width (narrow or wide)
• Fader assignment displays
• Remote devices display
• Masking Tape display

Figure 2.24 shows a console with all dis-
play options disabled. It contains three 
major elements:

A Console Name
This area always displays the name of 
your console (as assigned in the Con-
sole Window Menu).

B Console Window Menu
Use this pop-up menu to set numer-
ous display options, as discussed in 
The Console Window Menu (pg. 58).

AB C
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C Individual Console Channels
The Console Window contains one 
vertical strip for each console chan-
nel. The next section details the 
elements in a channel.

The Basic Console Channel

Figure 2.25: Single, Basic Console Channel

As you can see in Figure 2.25, a basic con-
sole channel contains the following 
elements:

A Channel Number
Displays the number for each console 
channel. This area is highlighted for 
the channel that contains the active 
control.

A

B

C

5

6

7

8

9

J K

4
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CHAPTER 7: The Console Windows
B Instrument Selector
Use this pop-up menu to select the 
Instrument that’s controlled by this 
channel. Faders can control either 
MIDI Instruments, Audio Instru-
ments, Buses, Inputs, or Outputs.

C Volume Fader
By default, this fader controls volume 
(MIDI control #7), but you can reas-
sign it to any MIDI control number as 
discussed in Show Selected Fader Info 
(pg. 60) or Show All Fader Info 
(pg. 62).
The active fader always appears 
highlighted.

TIP: You don’t have to drag faders to 
change them—simply click where 
you want the fader to be and it jumps 
to the new value immediately.
NOTE: If the fader is assigned to an 
Audio Instrument, it can only control 
the audio’s volume.
NOTE: If the Fader Slots in Instru-
ment Color option is checked in the 
Settings Window, the fader slots are 
displayed in the color of the assigned 
Send Instrument. 

Click here...

...and the fader 
jumps to that value.
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D Volume Thumb
Click and drag the Volume Thumbs 
to adjust the fader value. Each thumb 
is color-coded as follows:
MIDI channels are teal.
Audio channels are blue.
Busses are pink. 
Inputs are purple. 
Outputs are red.
TDM SampleCell inputs are orange. 
NOTE: The Bus, Input, and Output 
colors are only applicable to Acadia 
users or Studio Vision Pro users with 
TDM-compatible hardware. Sample-
Cell colors are only available to Studio 
Vision Pro users with SampleCell 
TDM. ReWire channels are available 
only to Acadia users with ReWire com-
patible soft synths. For more 
information, see your Audio Reference 
Manual.
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E Volume Fader Value
Displays the numerical value set by 
the Volume Fader. You can change 
this numerical directly and the 
Volume Fader will move to reflect the 
new value.
Any time you reassign a channel to a 
different Instrument (either manually 
or with one of the Build Console 
From commands), the faders change 
to display the current fader value of 
the new Instrument.
Audio volumes are now displayed in 
decibels. The value can range from 
negative infinity to the Maximum 
Fader Position setting (see your 
Audio Reference Manual for details).
If you reassign a channel to a MIDI 
Instrument that does not currently 
have a volume value, Vision sets the 
fader level to 127. If you reassign a 
channel to an Audio Instrument that 
does not currently have a volume 
value, Vision sets the fader level to 
0 dB.

F Volume LEDs
Displays MIDI or audio volume levels 
graphically.
If your audio hardware does not sup-
port output level metering, then the 
channel hides the level LEDs.

G Clipping Indicator
In Acadia audio mode, this indicator 
works only with audio Outputs—it 
indicates a clipped digital audio sig-
nal. In Acadia mode, Audio 
Instruments, Busses, and Inputs 
never clip. This is because Acadia 
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uses floating point in its computa-
tions, and with floating point there is 
practically no limit to the dynamic 
range for these audio signals.
In all other modes, this indicator 
works only with Audio Instruments; it 
indicates a clipped digital audio 
signal.

H Pan Fader
By default, this fader controls pan 
(MIDI control #10), but you can reas-
sign it to any MIDI control number 
when working with MIDI Instru-
ments. This fader can only control 
pan when working with Audio Instru-
ments, Busses, Inputs, and Outputs.

I Pan Fader Value
Displays the numerical value set by 
the Pan Fader. You can change this 
numerical directly and the Pan Fader 
will move to reflect the new value.
For MIDI Instruments, this value can 
range from <64 (left) to 63> (right).
For Audio Instruments, Busses, 
Inputs, and Outputs, this value can 
range from -100.00 to 100.00.

J Mute Button
Click this button to mute playback of 
the Instrument, Bus, Input, or Output 
controlled by this channel.
Opcode Systems, Inc.
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K Solo Button
Click this button to solo playback of 
the Instrument, Bus, Input, or Output 
controlled by this channel. Soloing a 
channel automatically mutes play-
back of any non-soloed channels.
Soloing an audio bus automatically 
results in all pre sends routed to that 
bus being heard (post sends are 
muted).

CREATING A CONSOLE 
“SNAPSHOT”

You can use the Copy Faders command 
to create a snapshot of fader values 
(including all Console faders). This is par-
ticularly useful for setting the mix at the 
beginning of a sequence.

For information about Copy Faders, see 
page 347 in your MIDI Reference Manual 
and page 89 in your MIDI Reference 
Manual.
Vision & Studio Vision Pro - What’s New in 4.5
THE CONSOLE WINDOW MENU

Figure 2.26: The Console Window Menu

The following sections discuss each item 
in the Console Window Menu:

Channel Width

Use the Channel Width command to 
specify one of two channel widths:

• Narrow
• Wide

The following sections discuss these two 
options in detail.
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Narrow

Select this option to reduce the display 
width of each console channel.

Figure 2.27: Channel Width set to Narrow

This option has pros & cons:

PRO: You can view more channels at a 
time on your computer screen.

CON: You lose some channel display 
capabilities. Specifically, if you select the 
Narrow option, channels won’t display:

• Volume bargraph (LED’s)
• Optional detailed channel information 

(such as Pan Fader Info, Fader Con-
trol selectors, and Remote Devices). 
These options are described later in 
this chapter.

Additionally, Instrument names in the 
Instrument Selector pop-up menu contain 
very few characters.
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Wide

Select this option to display each console 
channel at its maximum width.

Figure 2.28: Channel Width set to Wide

This option has pros & cons:

PRO: You can view all of the detailed 
information for each channel in the 
console.

CON: Each channel, since it’s wider, 
requires more screen space. Therefore, 
your computer screen can display fewer 
console channels at one time.

Audio Sends

The Audio Sends menu item (disabled 
for unsupported audio systems) allows 
you to create advanced routings using 
Acadia or Digidesign’s DAE with TDM-
equipped hardware. This feature is dis-
cussed in your Audio Reference Manual.
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Plug-Ins

The Plug-Ins menu item (disabled for 
unsupported audio systems) lets you 
apply VST or TDM plug-ins. This menu 
item is enabled only if you:

• are in Acadia mode
• own Studio Vision Pro and are using 

it to control TDM-equipped Digide-
sign audio hardware.

See your Audio Reference Manual for 
details.

EQs

The EQs menu item (disabled for unsup-
ported audio systems) lets you apply 
Vision’s realtime EQs to audio channels. 
This menu item is enabled only when you 
are in Acadia audio mode. This feature is 
discussed in your Audio Reference 
Manual.
Vision & Studio Vision Pro - What’s New in 4.5
Show Selected Fader Info

Select this option if you want the top of 
the Console Window to display detailed 
information about the selected (high-
lighted) fader.

Figure 2.29: Console with Show Selected Fader 
Info enabled

You can turn this option on and off by 
selecting it repeatedly—when the option 
is checked, it’s enabled and the fader info 
appears at the top of the Console Window. 
When the option is unchecked, it’s dis-
abled and the fader info does not appear 
at the top of the Console Window.

Selected fader information appears 
here, at top of window, when Show 
Selected Fader Info is checked.
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Figure 2.30 illustrates the different ele-
ments displayed by the Show Selected 
Fader Info option.

Figure 2.30: Anatomy of the Selected Fader Info 
Area

These are:

A Instrument Selector
This is the same as the Instrument 
Selector pop-up menu in the channel, 
but is wide enough to show the full 
Instrument name.

B MIDI Control Selector
Use this pop-up menu to assign a 
MIDI control number to the selected 
fader. It’s the same as the MIDI Con-
trol Selector displayed in each 
channel when Show All Fader Info 
is enabled as discussed in Show All 
Fader Info (pg. 62).
IMPORTANT: If the fader is assigned 
to an Audio Instrument, it can only 
control the audio’s volume or pan.

C Fader Value
This numerical displays the current 
value of the selected fader.

A B C D
E

F
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D Remote Device Selector
Use this pop-up menu to assign an 
external MIDI device to control the 
selected fader. This is particularly 
useful if you own a MIDI fader unit 
and wish to use it to control Vision’s 
faders.

E Remote Device Channel
Use this numerical to designate 
which MIDI channel is used by the 
Remote Device.

F Remote Controller Selector
Use this pop-up menu to select which 
MIDI controller on the external 
device will control the selected fader.

NOTE: Remote control of faders will not 
work until you check the Fader Remotes 
Enabled option in the Console Window 
Menu (or the Setups menu) as discussed on 
page 65.
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Show All Fader Info

Select this option if you want Vision to dis-
play detailed Instrument and MIDI 
controller assignments for each fader in 
each channel.

Figure 2.31: Wide Console with Show All Fader 
Info enabled

You can turn this option on and off by 
selecting it repeatedly—when the option 
is checked, it’s enabled and all fader infor-
mation appears in each channel. When 
the option is unchecked, it’s disabled and 
the fader information does not appear in 
the channel.

NOTE: There is not enough room to show 
all fader information if the console’s Chan-
nel Width is set to Narrow. Therefore, the 
option is disabled when narrow channels 
are displayed.
Vision & Studio Vision Pro - What’s New in 4.5
Figure 2.32 illustrates all the elements 
that are added to a single channel when 
you enable this option.

Figure 2.32: Anatomy of a console channel with 
Show All Fader Info selected

These are:

A Pan Instrument Selector
Use this pop-up menu to select the 
Instrument that’s controlled by the 
pan fader in this channel. Faders can 
control either MIDI Instruments or 
Audio Instruments.

B Pan MIDI Control Selector
Use this pop-up menu to assign a 
MIDI control number to the pan fader 
for this channel.
IMPORTANT: If the fader is assigned 
to an Audio Instrument, it can only 
control the audio’s volume or pan.

C Volume MIDI Control Selector
Use this pop-up menu to assign a 
MIDI control number to the volume 
fader for this channel.
IMPORTANT: If the fader is assigned 
to an Audio Instrument, it can only 
control the audio’s volume or pan.

A

B

C
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Show Remote Devices

Select this option if you want Vision to dis-
play the remote control assignments for 
the volume fader in each channel.

IMPORTANT: If you want to see remote 
device assignments for the pan faders, you’ll 
need to check the Show Selected Fader 
Info option as discussed in Show Selected 
Fader Info (pg. 60).

NOTE: Remote control of faders will not 
work until you check the Fader Remotes 
Enabled option in the Console Window 
Menu as discussed in Fader Remotes 
Enabled (pg. 65).

Figure 2.33: Wide console with Show Remote 
Devices enabled
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You can turn this option on and off by 
selecting it repeatedly—when the option 
is checked, it’s enabled and the remote 
devices appear in each channel. When the 
option is unchecked, it’s disabled and the 
remote devices do not appear in the 
channel.

NOTE: There is not enough room to show 
remote devices if the console’s Channel 
Width is set to Narrow. Therefore, the 
option is disabled when narrow channels 
are displayed.

Figure 2.34 illustrates the elements that 
are added to a single channel when you 
enable this option.

Figure 2.34: Anatomy of a console channel with 
Show Remote Devices enabled

A
B

C
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These are:

A Remote Device Selector
Use this pop-up menu to assign an 
external MIDI device to control the 
volume fader.

B Remote Device Channel
Use this numerical to designate 
which MIDI channel transmits the 
remote data.

C Remote Controller Selector
Use this pop-up menu to select which 
MIDI controller on the external 
device will control the volume fader.

Show Masking Tape

This option adds a blank “masking tape” 
region to the bottom of each console 
channel. The Masking Tape area can be 
used to label each channel. After choos-
ing Show Masking Tape from the 
Console Window Menu, simply click in 
the Masking Tape area and type in the 
name you want to display (see 
Figure 2.35, below).

Figure 2.35: Console Channel with Masking Tape

Click here and type the
channelÕs name.
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You can type anything you wish into this 
field; Masking Tape doesn’t necessarily 
correspond to the name of a specific 
track. For example, even though you may 
use the same Instrument for several 
tracks, this Instrument has only one Con-
sole channel. In this case, you could label 
the Console channel “Synths” to refer to 
all of the tracks that it controls.

Naming an Instrument vs. using 
Masking Tape

Many users find that they wish for a quick 
way to add names to a console’s channels. 
Vision’s consoles are designed to mimic a 
physical mixing console, so the Masking 
Tape region was added to give users 
more flexibility. You can use it to quickly 
label your console channels.

Vision also has the capability to rename 
Instruments (MIDI and Audio), Busses, 
Inputs, and Outputs. For instructions, 
please see page 294 in your MIDI Refer-
ence Manual. Renaming an instrument is 
actually a more thorough labeling 
method. The instrument’s name appears 
throughout the program, including the 
Thru Instrument popup, all edit windows 
(including the Tracks window), and the 
Record Monitor, but the Masking Tape 
field only appears in the console.

In general, it’s best to use Masking Tape 
as a “scratch pad” while you’re working 
on the fly and then rename your instru-
ments when you’re ready for serious 
editing.
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Fader Remotes Enabled

Select this option if you want to remote 
control Vision’s software faders with hard-
ware MIDI controllers.

TIP: Fader remotes are particularly useful 
if you own a MIDI fader unit. You can 
assign each hardware fader to remotely 
control one of Vision’s software faders.

You can assign a different MIDI device, 
channel, and controller number to each 
fader in each console channel. For more 
information, see Show Selected Fader Info 
(pg. 60) and Show All Fader Info (pg. 62). 
This command is also in the Setups 
menu.

Master Instrument

Use this option to determine how faders 
are assigned in each channel. Specifically:

• Enabled (checked)
If the Master Instrument option is 
enabled (checked), Vision assigns 
both faders in a channel to the same 
Instrument.
This is the default console because, in 
most instances, you’ll use the vertical 
fader to control volume and the hori-
zontal fader to control the same 
Instrument’s pan.
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Figure 2.36: Master Instrument mode 
enabled

For example, look at Figure 2.36. 
Console channels 1-4 control the 
volume and pan of K2000 MIDI chan-
nels 1-4.

• Disabled (unchecked)
If the Master Instrument option is 
disabled (unchecked), Vision lets you 
assign each fader in a channel to a dif-
ferent Instrument.
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Figure 2.37: Master Instrument mode 
disabled

For example, look at Figure 2.37. 
Console channels 1-4 use their 8 
faders to control the volume on 8 
K2000 MIDI channels.

Console Name

Use this command to rename the active 
console. To do so:

a Choose Console Name.

Vision opens a renaming dialog box.

b Type a new name.

c Click the OK button.

Vision renames the console.
Vision & Studio Vision Pro - What’s New in 4.5
Build Console From

Select the Build Console From com-
mand to produce a submenu of building 
options.

Figure 2.38: Build Console From submenu

Vision gives you the following options, 
each of which automates the console-
building process:

• Selected Tracks’ Instruments
• All Instruments In Use
• MIDI Instruments In Use
• Audio Instruments In Use
• Audio Instruments
• Enabled ReWire Channels

There are, however, several important 
points to consider when you ask Vision to 
build a console for you:

• When Vision builds a console, Vision 
automatically enables Master 
Instruments mode, ensuring that 
the two faders in each channel con-
trol the volume and pan of the same 
Instrument.

• When Vision builds a console, it 
“wipes out” any fader assignments 
you may have already made in that 
console. Should you wish to keep the 
console assignments you’ve already 
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created, open a new console (by 
choosing Windows>Consoles> 
<Console Name>) before using the 
Build Console From command.

The following sections discuss in detail 
each option for building consoles.

Selected Tracks’ Instruments

Choose this option if you want Vision to 
automatically build a console using the 
Instruments in all the selected tracks:

a In the Tracks Window, select those 
tracks you want to use to build a 
console.

b Open a new Console Window and 
choose Build Console 
From>Selected TracksÕ 
Instruments from the Console 
Window Menu.
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Vision creates a console that contains 
channels assigned to the Instruments in 
the selected tracks.

Notice that the console contains fader 
assignments for the four Instruments 
used by the selected tracks.

NOTE: This option creates console chan-
nels for both MIDI Instruments and Audio 
Instruments.

Build Console From All Instruments In 
Use

If you choose this command, Vision cre-
ates one or more consoles containing 
every Instrument (Audio and MIDI) used 
in every sequence in the entire Vision file. 
It first assigns all the MIDI Instruments to 
console channels. It then assigns all the 
Audio Instruments to console channels.
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Build Console From MIDI Instruments In 
Use

If you choose this command, Vision cre-
ates one or more consoles containing 
every MIDI Instrument used in every 
sequence in the entire Vision file. It 
ignores all Audio Instruments in the 
build.

Build Console From Audio Instruments 
In Use

If you choose this command, Vision cre-
ates one or more consoles containing 
every Audio Instrument used in every 
sequence in the entire Vision file. It 
ignores all MIDI Instruments in the build.

Build Console From Audio Instruments

If you choose this command, Vision auto-
matically builds one or more consoles 
containing all of Vision’s Audio Instru-
ments (whether they’re used in a Vision 
sequence or not).

Build Console From Enabled Rewire 
Channels

If you choose this command, Vision auto-
matically builds one or more consoles 
containing every enabled ReWire chan-
nel. ReWire channels are enabled in the 
Audio Instruments window. For more 
information, see your Audio Reference 
Manual.
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Clear Console

Choose this command to clear all Instru-
ment assignments in the Console 
Window. If one or more audio channels in 
the Console has plug-in, send, or EQ 
assignments, you will see the following 
dialog.

If Clear plug-ins, sends, and EQs as 
well is checked, all plug-in automation 
data will be cleared. EQ and send automa-
tion data will remain, but it won’t have any 
direct effect on the sequence unless EQs 
or sends are reassigned.

Fader values are not cleared.

Save Console Layout

Choose this command to save the infor-
mation in the Console to a template file. A 
“Console Layout Templates” folder is cre-
ated within the Vision folder the first time 
you choose this (or the Save Console 
Layout As...) command. Each Console 
Layout template is stored as a separate 
file within this folder. When you choose 
Save Console Layout, one of these files 
is created in the Console Layout Tem-
plates folder. The name of the file is the 
name of the current Console.
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Choosing this option multiple times 
within the same Console will simply 
update the previously saved file. However, 
if you change the name of the Console 
and then choose Save Console Layout 
again, a new file with the Console’s new 
name will be generated.

The following information is stored in a 
Console Layout template:

• Console name (stored as the name of 
the Console Layout Template file);

• Channel width;
• Enabled display options (“Show” 

options under the Console menu);
• Number of Sends displayed;
• Number of Plug-ins displayed;
• EQ display settings;
• Instrument assignments;
• Remote device assignments;

The following information is not stored in 
a Console Layout template:

• Fader values;
• Plug-in assignments or parameters;
• Send assignments or parameters;
• EQ parameters;
• Output assignments.

This feature is designed so that loading a 
Console Layout will NOT delete your cur-
rent fader values, output assignments, or 
plug-in, send, and EQ settings. Console 
layouts effect only the display of the con-
sole, not the information that is already 
saved elsewhere in the sequence.
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Save Console Layout As...

This option works exactly like Save Con-
sole Layout except that it gives you an 
opportunity to name the file you’re saving. 
After choosing Save Console Layout, 
this dialog box appears.

Type in a name for the Console Layout 
template file here. This will not change 
the name of the current Console. It will 
name the file within the Console Layout 
Templates folder.

Load Console Layout

Use this option to recall a Console Layout 
template you’ve already saved (using the 
Save Console Layout or Save Console 
Layout As... commands). Choosing this 
command will apply the Console Layout’s 
settings to the current Console.
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Select the Layout you want to load and 
press Open. The Layout settings stored 
in the selected Console Layout file are 
applied to the current console.

Again, loading a Console Layout will NOT 
delete your current fader values, output 
assignments, or plug-in, send, and EQ set-
tings. Console layouts effect only the 
display of the console, not the information 
that is already saved elsewhere in the 
sequence.

You may need to navigate (in the Load 
Console Layout dialog box) to the “Con-
sole Layout Templates” folder in your 
Studio Vision folder in order to see your 
available Console Layouts.

IMPORTANT NOTE: A Console Layout 
Template cannot be opened by double-click-
ing its icon. You must use the Load 
Console Layout Template command. 
Double-clicking a Console Layout Template 
will launch Vision, but it will not open (or 
load) the template itself.

FADER GROUPING

You can select multiple faders and move 
them as a group. Fader groupings are 
temporary and disappear once the selec-
tion is disabled.
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Selecting Multiple Faders

You can select multiple faders using one 
of two methods:

• contiguous selection—all faders in a 
group are physically next to each 
other in the console.

• discontiguous selection—selected 
faders can be anywhere in the con-
sole. They don’t have to be next to 
each other.

To create a contiguous selection:

a Click a fader to select it.

Vision highlights the fader to show itÕs 
selected.

b Shift-click a second fader some 
distance from the first.

Vision selects the second fader and 
every fader in between it and the first.

Figure 2.39: Contiguous Selection

This is a contiguous selection, and is a 
quick way to select a long block of faders 
with only two clicks.

All three faders are selected
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To create a discontiguous selection:

a Click a fader to select it.

Vision highlights the fader to show itÕs 
selected.

b Command-click a second fader some 
distance from the first.

Vision adds the second fader to the 
grouping.

Figure 2.40: Discontiguous Selection

Notice in this example that, unlike 
Figure 2.39, the middle fader isnÕt 
selected.

c Continue to Command-click 
additional faders until youÕve 
completed your grouping.

NOTE: To clear a fader grouping, click in 
any non-active area of the console.

Only these two faders are selected
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Moving Faders as a Group

Once you’ve created a group of faders, 
Vision offers you three different ways in 
which to move them:

• Absolute fading— all grouped 
faders move the same amount up or 
down.

• Proportional fading—all grouped 
faders move proportionally, so that 
they all reach their minimum or maxi-
mum positions simultaneously.

• Snap fading—all grouped faders 
move to a single level.

Each of these methods is discussed in the 
following sections.

Absolute Fading

Drag any one fader and all grouped faders 
move by the same amount. The following 
example illustrates how to perform abso-
lute fading with a group of faders:

a Create a group of faders.

This is discussed in Selecting Multiple 
Faders (pg. 70).

Figure 2.41: Three grouped faders
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b Drag any fader up or down.

All grouped faders move the same 
amount.

In this example, notice that each fader 
value was reduced by 40.

c Continue dragging until the fader 
Òbottoms out.Ó

In this example, the dragged fader is the 
first to reach Ò0,Ó so no additional 
decrease can occur in the values of the 
other faders.
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If you dragged that same fader up, it 
would be the last to reach 127.

Proportional Fading

Option-drag any one fader and all grouped 
faders move proportionally, so that they 
all reach the bottom (or top) of their fade 
simultaneously. The following example 
illustrates how to perform proportional 
fading with a group of faders:

a Create a group of faders.

This is discussed in Selecting Multiple 
Faders (pg. 70).

Since youÕre dragging the lowest-valued 
fader in the group, all the other faders 
reach 127 before it does.
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Figure 2.42: Three grouped faders

b Option-drag any fader up or down.

All grouped faders move proportionally.

In this example, notice that the dragged 
fader was reduced by 40, but that the 
other two grouped faders were reduced 
substantially more.

This is because, in proportional fading, 
all the faders move so that they reach 
the bottom (or top) of their fade 
simultaneously.
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c Continue Option-dragging until the 
fader Òbottoms out.Ó

With proportional fading, all faders reach 
their minimum or maximum values 
simultaneously.

Snap Fading

Control-click within any one fader and all 
grouped faders snap to that value. The fol-
lowing example illustrates how to perform 
snap fading with a group of faders:

a Create a group of faders.

This is discussed in Selecting Multiple 
Faders (pg. 70).

Figure 2.43: Three grouped faders
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b Control-click anywhere along a fader 
path.

All grouped faders snap to that value.

Control-click here
Vision & Studio Vision Pro - What’s New in 4.5
REARRANGING CONSOLE 
STRIPS

Dragging Strips Horizontally

It is now possible to rearrange the order 
console strips by dragging them horizon-
tally. To do this:

a Set up your console.

In this example, console strip 1 will be 
moved. Its volume and pan have been 
set to make it easily recognizable.

b Click and hold on the number at the 
top of the strip youÕd like to move.
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c Drag the mouse to your destination 
(where you want the strip to be in the 
Console).

In this example, strip 1 will be moved 
between strips 3 and 4.

d Release the mouse button.

Strips 2 and 3 are moved to the left and 
strip 1 is inserted between strips 3 and 4.

Notice that the Console strips are always 
numbered from left to right. This does not 
(in any way) change their functionality.
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Dragging Plug-Ins Vertically

Just as Console strips can be dragged hor-
izontally, plug-ins can be dragged 
vertically within a Console strip. This pro-
vides a quick and easy way to change the 
order in which plug-ins affect your audio 
signal. Plug-ins are always applied in 
ascending numerical order (1, 2, 3, and 
then 4).

To vertically drag a plug-in:

a Click and hold in the Plug-In Type 
area of the plug-in you wish to move.
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b Drag to the plug-inÕs desired location.

In this example weÕre moving the third 
plug-in so that it will be first.

c Release the mouse.

The plug-ins are rearranged.

NOTE: It is not possible to drag plug-ins to 
incompatible locations. For example, you 
cannot drag a mono plug-in to occur after a 
stereo plug-in or a mono in/stereo out 
plug-in. For more information about mono 
and stereo plug-ins and audio plug-ins in 
general, see your Audio Reference Manual.
Vision & Studio Vision Pro - What’s New in 4.5
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Figure 3.1: The Faders Window

ABOUT FADERS

Vision supports up to 800 faders that are 
divided into two categories:

• Faders 1-32 are controlled from the 
Faders Window, as shown in 
Figure 3.1.

• The sixteen Console Windows, each 
represented as a mixing board, con-
trol the other 768 faders.

NOTE: Each Console Window can contain 
up to 24 channels, and each channel con-
tains 2 faders. The fader that appears to be 
a pan control is, in fact, fully assignable, as 
is the main fader.
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Each fader can be set to send any MIDI 
controller (except pitch bend and after-
touch) or volume or pan for any audio 
Instrument, Bus, Input, or Output. Each 
fader can be controlled directly with the 
mouse or by an external MIDI controller. 
Faders can also be grouped and con-
trolled from the same external MIDI 
controller. One fader can control tempo.

When a fader’s movements are recorded 
and its window is open, the results are 
audibly and visually represented during 
playback. These movements are recorded 
as automation events in the record-
enabled track. These events can be 
viewed and edited in either the List 
Window (see page 261 in your MIDI Ref-
erence Manual) or the Strip Chart (see 
page 241 in your MIDI Reference Man-
ual). Specific events can be selected for 
editing or remapping using the Select & 
Modify Window (see page 119 in your 
MIDI Reference Manual).

Vision handles automation events identi-
cally whether they originate from the 
Faders or Console Windows. Although 
this chapter discusses the Faders Win-
dow, feel free to consult Chapter 7: The 
Console Windows and the Automation 
chapter of your Audio Reference Manual 
to correlate ideas between these related 
features.
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THE FADERS WINDOW

The Faders Window can be displayed in a 
single column consisting of 16 faders, 
beginning with either Fader 1 or 
Fader 17; or in two columns, showing all 
32 faders. This display option is controlled 
in the bottom right of the window.

To the left of the display options, at the 
bottom of the Faders Window, is a toggle 
that controls what the window displays:

• Send: The controllers the faders are 
sending data to
or

• Rcv: The external controllers the 
faders are controlled from

Fader Values

The field to the right of the fader name 
(F1, F2 etc.) shows the numerical value 
for that fader. Clicking and dragging up or 
down in the fader value numerical allows 
the value to be precisely set. Values may 
also be typed in from the computer key-
board. The range of values is 0-127.

Although Console faders assigned to cer-
tain parameters may have different value 
ranges, faders in the Faders window will 
always have a range of 0-127. These 
values are automatically remapped to 
appropriate values when recording, and 
vice versa. For example, if you set the 
Maximum Fader Position value to 
+6 dB, record a fade from 127 to 0 on a 
fader assigned to Audio Volume, and then 
view those events in the List window, the 
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values for the events will be between 
+6 dB and -¥. Playing those events (with 
+6 dB to -¥ values) will still result in the 
fader numerical displaying values 
between 0 and 127.

Fader Sliders

The fader’s slider may be dragged to 
change the value in the numerical field. 
Faders that are controlled by external 
devices move automatically in response to 
their assigned controller. Dragging the 
slider sets the fader to even-numbered 
values (and 127). 

If the Fader Slots in Instrument Color 
option is checked in the Settings Window, 
the fader slots are displayed in the color 
of the assigned Send Instrument. 

Instrument, Device, Channel 
Number and Controller

When the Faders Window is showing the 
Send settings, the Instrument and Con-
troller pop-ups determine where the fader 
sends its data.

When the Receive settings are shown, the 
Device, Channel and Controller pop-ups 
determine the source of the fader’s 
control.

Tempo Fader Assign

One fader can be set to control the tempo. 
See page 138 in your MIDI Reference 
Manual for more information.
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Tempo Fader Range

These numericals determine the range 
available to the Tempo fader.

Send/Receive Settings Display

Clicking this field toggles the Faders 
Window display between the Send and 
Rcv settings.

Send Settings

Each fader can be used to send an auto-
mation event to a selected Instrument, 
Bus, Input, or Output:

a Set the Send/Receive toggle to Send.

b Activate the desired fader by clicking 
on its selector dot.

The selector dot changes into a hollow 
triangle.

c Select an Instrument, Input, Output, 
or Bus from the Instrument pop-up 
menu. 

d Select a controller from the Controller 
pop-up menu.

Volume (7) is the default that is initially 
displayed. Pitch bend and aftertouch are 
not available.

If an Audio Instrument, Input, Output, or 
Bus is selected, the only available send 
destinations are Volume and Pan. Click-
ing on the setting alternates between the 
two options.
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Whenever the fader is moved, the 
assigned automation events are sent to 
the selected Instrument. Moving a fader 
while recording causes Vision to record 
the automation events for the record-
enabled track.

One fader can control the volume of sev-
eral MIDI channels by setting up an 
Instrument with several layers, each layer 
set to one of the desired MIDI channels, 
and then selecting that Instrument to 
receive the fader’s volume information.

Receive Settings

To control a fader using an external MIDI 
controller such as a modulation wheel, 
MIDI fader unit, or continuous pedal:

a Select Fader Remotes Enabled 
from the menu in the Faders Window.

This allows the information from remote 
MIDI controllers to reach the faders.

b Set the Send/Receive toggle to Rcv.

c Enable the fader by clicking its 
selector dot. 

The device, channel and controller 
number are displayed that currently pro-
vide external control for that fader.

d Each numerical can be individually 
set using any of VisionÕs standard 
procedures.

An easier method is to click on each field 
and then move the external MIDI control-
ler that controls that fader. The 
information is automatically transmitted 
to the selected field.
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This process results in the external MIDI 
controller moving the fader to which it is 
assigned. The fader, in turn, sends the 
automation information assigned in the 
Send mode to the assigned Instrument, 
Input, Output, or Bus. Multiple faders can 
be controlled from a single external MIDI 
controller.

Fader Display Mode

Three different display modes are avail-
able for the Faders Window by clicking 
the 1, 17 or 32 fields in the bottom right 
corner of the window: 

• 1: The Faders Window consists of 16 
faders in one column beginning with 
Fader 1.

• 17: The Faders Window consists of 
16 faders in one column beginning 
with Fader 17. 

• 32: The Faders Window consists of 
32 faders in two columns beginning 
with Fader 1. 

FADER FUNCTIONS

Using Faders to Remap MIDI 
Controllers

Faders can remap a MIDI controller’s 
function by selecting one controller type 
to control the fader (with the Rcv setting) 
while assigning a different controller type 
to be sent by the fader (with the Send 
setting). 
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Using Faders to Control 
Instrument Velocities

Most MIDI synthesizers respond to MIDI 
Volume (control #7) but certain older syn-
thesizers do not. Vision allows a pseudo-
volume mix by using faders to control 
Instrument velocities instead of volume. 
Since velocity normally corresponds to 
note amplitude on most synthesizers, 
varying a note’s velocity is similar to vary-
ing channel volume. 

NOTE: Although velocity usually corre-
sponds to note volume, it may also affect the 
timbral aspects of the sound as well. Check 
the synthesizer manual for details.

Each Instrument layer can modify the 
velocities of the notes it plays. Two col-
umns in the Instruments Window control 
this action: 

• Velocity Scale checkbox: Any of 
Vision’s 800 faders can be assigned to 
control Velocity Scale for any instru-
ment. This checkbox enables the 
instrument to respond to Velocity 
Scale messages. Unchecking this box 
will cause the instrument to ignore 
Velocity Scale information assigned 
to it.

• Velocity Scale %: The amount can 
range from 1% to 250%. 

At the fader’s maximum level (127), the 
velocity output is the recorded velocity 
multiplied by the scaling factor. These 
settings affect all note velocities played by 
that Instrument layer.
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For example, if a note is recorded at a 
velocity level of 64 and the Velocity Fade 
Amount is set to 50%, then a fader level of 
127 equals a velocity of 32 (50% of 64).

Moving the fader while the sequence is 
playing changes the velocity of notes 
assigned to that Instrument. Fader move-
ments can now be recorded and used as 
pseudo-volume controllers for MIDI 
devices that don’t respond to Volume 
(control #7).

For more details, please see page 297 in 
your MIDI Reference Manual.

Copying Fader Settings

When the Fader Window is active, choos-
ing Edit>Copy Faders places an 
automation event for each defined fader’s 
current value onto the Clipboard. The 
fader events can then be pasted into a 
track, creating a “snapshot” of the current 
fader values.

This is particularly useful for creating a 
mix at the beginning of a sequence. To 
ensure that your sequence begins with 
the correct mix, it is a good idea to place a 
fader snapshot at the beginning of the 
sequence. This process is very important, 
but it is often overlooked.
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For example, you might use volume 
faders to create a “fade out” at the end of a 
song, with each instrument’s volume set-
ting ending at 0. The first time the 
sequence is played, it sounds correct. 
After the sequence ends, you press play 
again, but can’t hear anything. If you let 
the sequence play long enough, you’ll 
hear only the fade out.

This happens because, at the end of the 
song, each instrument receives a volume 
setting of 0. If there’s no volume data at 
the beginning of the sequence, the instru-
ment doesn’t know to change its volume 
until the first volume event of the fade out. 
Creating a set of initial volume settings (a 
“snapshot” of the Console and Faders 
windows) will alleviate this problem.

Copy Faders now automatically inserts 
Mute and Solo automation events for 
MIDI Instruments in addition to any other 
MIDI controller events that are assigned 
in the Faders or Console windows.

For more information about the Copy 
Faders command, please see page 89 in 
your MIDI Reference Manual.

CHANGES IN THE WAY VISION 
HANDLES FADERS

Removal of “fader events”

In previous versions of Vision, faders 
were a type of interface between you and 
your MIDI controller data.
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Figure 3.2: The old way

Faders still act as an interface, but now 
they generate data directly. Instead of cre-
ating a fader event assigned to another 
parameter (such as a controller), faders 
now create controller (or automation) 
events.

Figure 3.3: The new way

In short, we’ve “eliminated the middle-
man” by completely removing “fader 
events”.

Visual and Audible Effect

In most cases, the visual and audible 
effects of recorded fader movements will 
not change. In fact, faders themselves 
have become much more flexible. For 
example:

A fader set up like this...

...used to generate an event like this
(in the List Window).

A fader set up like this...

...will now generate an event like this
(in the List Window).
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a Open the Faders window and assign 
the first fader to control pan for a MIDI 
instrument.

This example uses JD-800-1.

b Record enable a track.

c Press the Record button.

d Click on the fader and drag it back 
and forth to record pan information.

e Press the Stop button and open the 
List window.

You can see the pan events in the list 
window.
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Notice that these are not fader events 
assigned to pan; they are pan events.

f Press Play

Watch the first fader move just as you 
recorded it.

g Disable the first fader by clicking on 
its selector dot.

h Enable a different fader and set it to 
JD-800-1 Pan.

i Press Play.

Now the new fader moves to the 
recorded pan events.

You could also assign a Console channel 
to JD-800-1 and the pan fader in that con-
sole would move in unison as well.
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Notes About Audio Volume and 
Pan

As in previous versions of Vision, audio 
volume and pan can be displayed in the 
Faders window and controlled by its 
sliders.

Audio pan now has a range of -100.00 to 
100.00, and audio volume now has a range 
of -¥ to the Maximum Fader Position (as 
set in the Audio Preferences dialog box). 
However, displayed fader values in the 
Faders window are still 0-127.

These values are mapped to the appropri-
ate range of values (for the selected 
parameter). In the case of audio pan, 0 
corresponds to -100.00 (left) and 127 cor-
responds to 100.00 (right). For audio 
volume, 0 corresponds to -¥ and 127 cor-
responds to the Maximum Fader 
Position.

If you wish to see the correct numeric 
values for these parameters, use the Con-
soles rather than the Faders window.

For more information, see your Audio Ref-
erence Manual.

Changes in Copy Faders

The Copy Faders command is most 
often used to create a “snapshot” of fader 
values for several different instruments.
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Since fader values are now mapped 
directly to controller values (as described 
on page 81) which are in turn assigned to 
instruments, pasting the information gath-
ered during Copy Faders into a track will 
now result in a multi track.

For instance, if you invoke the Copy 
Faders command when you have a Con-
sole set up like the one above, the events 
inserted into a track will look like this in 
the List window.
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The track’s instrument is now set to multi, 
and automation events have been inserted 
for each instrument’s faders and mute and 
solo buttons.

If desired, you can use the Separate 
Multi Track command to put each instru-
ment’s events onto separate tracks. See 
page 49 in your MIDI Reference Manual 
for details.

Copy Faders and Audio Channels

When using the Copy Faders command 
with audio channels defined in the Con-
sole, you may end up with more data than 
you were expecting. For instance, EQ 
Enable, EQ Band Enable and EQ Band 
Parameters, Plug-in Bypass, and Send 
Levels are some of the event types that 
can be copied. See your Audio Reference 
Manual for more information about Copy 
Faders and audio channels.
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The List Window displays a chronological 
list of all events in a track as text and num-
bers. List Windows are used for the 
following track types:

• Performance track (normal track)
• Tempo track
• Meter track

List Windows for normal tracks may con-
tain events for notes, patch changes, 
digital audio, text-type, pitch bend, con-
trollers, aftertouch, poly aftertouch, 
automation (plug-in and EQ parameters, 
etc.), system exclusive, and sequence 
events.

Figure 4.1: List Window 
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List Windows for Meter tracks contain 
events for meter changes, markers, and 
key signatures.

Figure 4.2: Meter track List Window

List Windows for Tempo tracks contain 
events for tempo changes.

Figure 4.3: Tempo track List Window
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OPTS MENU

In previous versions of Vision, a Seqs 
menu appeared in the List window and 
Tracks/Pulse window expanded info area 
for tracks with sequence events in them. 
The menu is now called Opts, and it con-
tains an additional command that can 
apply to any track, regardless of whether 
or not the track contains sequence events. 
For that reason, the menu appears in the 
List window (and Tracks/Pulse Window 
expanded info area) for all performance 
tracks.

Song Track

Song Track is available only when the 
List window displays a performance track 
containing sequence events.

Check this option to copy the tempo infor-
mation from the referenced sequences (in 
that track) to the parent sequence. This 
lets the parent sequence play back with 
the tempo of the referenced material. 

The parent sequence’s Meter and Tempo 
tracks are updated automatically if any 
changes are made to the sequence events 
contained in the Song Track.
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Each sequence can only have one Song 
Track. If you already have Song Track 
enabled for one track, enabling it for 
another track disables the option for the 
previous track.

Keep Sequences End-to-End

Keep Sequences End-to-End is avail-
able only when the List window displays a 
performance track containing sequence 
events.

When both Song Track and Keep 
Sequences End-to-End are checked, 
Vision keeps sequence event blocks 
neatly together, one after another (the 
end point of one sequence event is the 
start point of the following sequence 
event). This is a handy option when chain-
ing together sequences to make songs.

Dragging, resizing, or changing the 
number of repeats for any sequence event 
block (as well as inserting or deleting 
sequence events), causes existing 
sequence events to move accordingly.

Also, the Meter and Tempo tracks of the 
parent sequence automatically change to 
match those of the sequence events resid-
ing in the Song Track. All meter, tempo, 
key, and marker events in the referenced 
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sequences therefore end up in the parent 
sequence. In addition, a marker is auto-
matically inserted at the beginning of 
each sequence event with the name of the 
referenced sequence or segment.

IMPORTANT: In order for a parent 
sequence to use both the Meter and Tempo 
tracks of the sequence events in the Song 
Track, both options in the Sequence Event 
pop-up must be checked.

Figure 4.4: Sequence Event pop-up in List Window

Lock Event SMPTE Times

Lock Event SMPTE Times is available 
for all performance tracks.

When checked, this option locks the 
SMPTE time of each event in the track so 
that even if you change the tempo of the 
sequence, each event in the track will play 
at the appropriate SMPTE time.

This is especially useful if you are scoring 
a film and want to set up a “sound effects” 
track. Simply check Lock Event SMPTE 
Times in the Opts menu for that track, 
and you can freely change the tempi of 
the music in the sequence without affect-
ing the sound effects.

You can check Lock Event SMPTE 
Times for any number of performance 
tracks.
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INSERTING EVENTS

Choose an item from the Insert Events 
pop-up to insert it into the track at the Edit 
In point. The available event types depend 
on the type of List Window currently 
active.

After inserting a particular event type into 
the List Window, you can click the Insert 
Events icon like a button (without high-
lighting the event type in the pop-up) to 
insert the same event type again.

Performance Track List Windows

Figure 4.5: Insert Event pop-up for performance 
Track

Notes

Note events display the pitch (note num-
ber), duration, velocity, and (optionally) 
release velocity.
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Durations are displayed as quarter notes 
and units. Durations, pitch and velocity 
are editable using the mouse or computer 
keyboard. Pitch and velocity are also edit-
able by selecting the item and playing a 
MIDI controller.

Audio Event

Choosing Audio Event automatically 
opens the Import Audio dialog box. The 
audio event(s) inserted will be placed at 
the current insertion point.

For more information about Import 
Audio, see your MIDI Reference Manual.

Patch

Patch events can be displayed as numbers 
or names. After being inserted with the 
Insert Events pop-up, they can be 
changed by clicking them and selecting a 
new patch from the Patch pop-up that 
appears.

Unless you use the Names Window to 
assign a Patch Name document to a 
device, it will display its patch changes as 
numbers. For more information, see 
Chapter 33: The Names Window in your 
MIDI Reference Manual. 

The rightmost part of the patch line con-
tains a pop-up menu.
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NOTE FOR MIDI NOVICES: The maxi-
mum number that can be sent in a MIDI 
program change message is 127. However, 
double program change and bank select 
messages can be used to access patches 
beyond the “127” limit.

Using this menu accesses the five differ-
ent types of patch change messages. The 
different types allow patch changes on 
synths that have more than 128 patches 
via bank select messages, or multiple pro-
gram change messages. In all cases, there 
will be numericals next to the boxed icons 
that can be set to the appropriate values. If 
you are using the OMS Name Manager to 
provide patch names, you won’t need to 
set the numericals manually; they will be 
filled in automatically whenever a patch is 
selected.

Following is a description of the five types 
of patch change messages:

• PC: Sends a program change mes-
sage only.

• PC PC: Sends two program changes 
in rapid succession. Some synths use 
the first message to set the hundreds 
digits and the second message to set 
the tens and ones digit. For example, 
PC 105 PC 38 would set the channel 
to program 538.

• B0 PC: Sends a bank select 0 mes-
sage followed by a program change.

• B32 PC: Sends a bank select 32 mes-
sage followed by a program change.

• B0 B32 PC: Sends a bank select 0 
message, a bank select 32 message, 
and a program change.
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Check your synthesizer’s documentation 
to find out which patch change messages 
it supports.

Text-type

Text-type events allow storage of text 
comments, copyright information, 
descriptions of Instruments, lyrics, or cue 
points in tracks, along with MIDI informa-
tion. The List Window displays as much of 
the text event as fits on one line. Text-type 
events may actually occupy several lines 
in the Text Edit dialog but only the infor-
mation that fits is displayed on one line in 
the List Window.

Text-type events include:

• Cue Points
Typically describes action taking 
place on film or video occurring at a 
specific SMPTE time.

• Lyrics
Words may be exported to notation 
programs supporting this feature.

• Instruments
Verbal descriptions of Instruments 
can enable subsequent orchestration 
in a different MIDI environment.

• Copyright
Provides a place to store a copyright 
notice.
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•  Text
Can be used for any text including 
comments, reminders etc.

Inserting a new text-type event, or click-
ing on an existing one, opens the Text 
Edit dialog allowing display and editing 
for the entire event. Any text can be typed 
in, and cut, copy, and paste operations can 
be performed by typing Command-X, 
Command-C, and Command-Y, respec-
tively (these commands are not available 
from the Edit menu). When finished, type 
the Enter key to insert the text into the 
track.

Pasting markers from the Meter track 
into a normal track converts bar markers 
to text-type events, and SMPTE markers 
to cue point events. This process may also 
occur in reverse with cue points and text-
type events pasted into the Meter track.

MIDI

Figure 4.6: MIDI Submenu

• Pitch Bend

Pitch Bend events display the bend 
amount as a number from -8192 to 
+8191.
Opcode Systems, Inc.



CHAPTER 9: The List Window
• Aftertouch

Aftertouch events are displayed as an 
editable number between 0 and 127.

• Poly Aftertouch

Polyphonic Aftertouch events display 
the pitch and controller amount (0–
127). The pitch is edited by selecting 
it and either playing a new note on a 
MIDI controller, or by using the 
mouse or computer keyboard.

• Velocity Scale

Velocity Scale events are displayed as 
a number from 0 to 127. For more 
information about Velocity Scale, 
please see page 297 in your MIDI Ref-
erence Manual.

• Controllers

Controller events display the control-
ler name, number and value (in that 
order). The eight Favorite Control-
lers (as defined in page 336 in your 
MIDI Reference Manual) and a 
generic “Controller” item are avail-
able in the MIDI pop-up menu. When 
“Controller” is selected, a Volume 
event (MIDI Controller #7) is 
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inserted by default. You can then 
click on “Volume” and select a new 
controller from the pop-up that 
appears.
Controller events previously inserted 
are also changed by clicking them 
and selecting a new controller from 
the pop-up that appears.
If Fine Controls is checked in the Set-
tings Window, values for pairs of 
controllers are shown as numbers 
from 0 to 16383.

Automation submenu

Figure 4.7: Automation submenu

• Audio Volume

Values can range from -¥ to +24 dB. 
For details, see your Audio Reference 
Manual.

• Audio Pan

Values range from <100.000 (left) to 
100.000>(right).
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• Mute

Mute events can have values of Off 
and On. The value is toggled by click-
ing on the word “Off” (or “On”).
Unlike most of the other commands 
in this menu, Mute can affect Audio 
or MIDI Instruments. Keep in mind 
that these events affect Instruments 
rather than tracks.
For details, see your Audio Reference 
Manual.

• Solo

Solo events can have values of Off 
and On. The value is toggled by click-
ing on the word “Off” (or “On”).
Unlike most of the other commands 
in this menu, Solo can affect Audio or 
MIDI Instruments. Keep in mind that 
these events affect Instruments 
rather than tracks.
For details, see your Audio Reference 
Manual.

• Send (1-4) Level

These options can write Send Level 
events for each specific send. The 
number of the Send that will be 
effected is displayed in the left col-
umn. Values range from negative 
infinity to +24 dB.
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• Plug-in (1-4) Bypass

Plug-in Bypass events can have Off 
and On values. When set to Off, the 
plug-in will be applied to the audio 
signal. When set to On, the plug-in 
will be bypassed. The value is toggled 
by clicking on the word “Off” (or 
“On”).
In the List window, these events 
appear with the name of the effected 
plug-in on the left, followed by the 
word “Bypass”, followed by the On/
Off status.

• Phase Invert

Phase Invert events can have values 
of Off and On. The value is toggled by 
clicking on the word “Off” (or “On”).

• EQ Enable

EQ Enable events can have values of 
Off and On. The value is toggled by 
clicking on the word “Off” (or “On”).

For more information about these auto-
mation events, please see your Audio 
Reference Manual.
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EQ Band Parameter submenu

Figure 4.8: EQ Band Parameter submenu

• Frequency

Controls the frequency of the speci-
fied EQ band. Values can range from 
20.00 Hz to 20000.00 Hz.

• Gain

Controls the gain of the specified EQ 
band. Values can range from -
18.00 dB to +18.00 dB.

• Width

Controls the width of the specified 
EQ band. Values can range from 0 to 
4.00 octaves.

• Type

Allows you to change the EQ type for 
the specified band. Clicking on the 
EQ Type setting opens a pop-up 
menu with all five EQ types.
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• Enable

EQ Band Enable events can have 
values of Off and On. The value is tog-
gled by clicking on the word “Off” (or 
“On”).

For more information about these auto-
mation events, please see your Audio 
Reference Manual.

Plug-in Parameter submenu

The Plug-in Parameter submenu lists 
the plug-ins that are assigned to the 
selected track’s Audio Instrument. For 
example:

Figure 4.9: Plug-in Parameter submenu

After you select a plug-in, another pop-up 
menu appears to the right. This menu dis-
plays the selected plug-in’s parameters. 

...then the Plug-in Parameter
submenu looks like this.

If the Console looks like this...
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For example, if you select opECHO, you 
might see the following:

“Dry/Wet” is the default parameter 
because it is the first parameter of the 
selected plug-in. Clicking on “Dry/Wet” 
will produce a pop-up menu that contains 
the selected plug-in’s parameters.

If you open the plug-in edit window for 
opECHO, you will see that the parameters 
listed in the pop-up menu correspond to 
the parameters of the opECHO plug-in.

Vision can automate up to 1024 parame-
ters per VST plug-in.

All plug-in parameters, regardless of their 
ranges in the plug-in edit window, will 
have values between 0.0000 and 100.0000 
in the list window. The plug-in’s range of 
possible parameters in the plug-in edit 

Plug-in
parameters
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window is mapped onto this scale. When 
the events are played back, they are 
mapped the opposite way; plug-in automa-
tion will still have appropriate values in 
the plug-in edit windows.

For more information about these auto-
mation events, please see your Audio 
Reference Manual.

System Exclusive

The number in parenthesis indicates the 
length of the event, in bytes. To edit the 
system exclusive data, click on the actual 
event.

When inserting a System Exclusive event, 
the Sysex Edit dialog appears, allowing 
viewing and editing of the sysex data.

Figure 4.10: System Exclusive dialog

In this dialog, entry is limited to valid 
hexadecimal characters. Each byte (2 hex 
characters) is separated by spaces. 
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NOTE: There are 16 possible hex digits: 
0-9, and A–F (corresponding to 10–15). 
Consult a MIDI reference text to learn more 
about hex numbers and their use in MIDI 
applications

You can cut, copy, and paste within the 
Sysex Edit dialog by typing Command-X, 
Command-C, and Command-Y, respec-
tively (these commands are not available 
from the Edit menu). When pasting into 
the Sysex Edit dialog, all non-hexadeci-
mal characters are removed. Click OK to 
exit the dialog box. The computer beeps 
to indicate invalid entries and highlights 
them for correction. Of course, clicking 
Cancel exits without changing any 
events.

Sequence Events submenu

There are five different types of sequence 
and transpose events. See page 103 in 
your MIDI Reference Manual for more 
information.
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Meter Track List Windows

When the List Window of a Meter track is 
active, there are three event types avail-
able from the Insert Events pop-up menu. 
see Figure 4.11. Changes to meter and 
key signature affect every track in the 
sequence.

Figure 4.11: Insert Event pop-up in Meter track 
List Window

Inserting Meter Changes in a List 
Window

Meter change events can be located only 
at the beginning of a measure. Both the 
top and bottom numbers of the meter are 
editable. The metronome click rate and 
the number of measures the meter will be 
active are also editable.

Figure 4.12: Meter Change Event

Meter Metronome click # of Bars
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Inserting Key Changes in a List Window

After inserting a key change event by 
choosing Key Signature from the Insert 
Events pop-up, the key can be edited by 
clicking the key and selecting from a pop-
up of available keys. Clicking the word 
“major” or “minor” toggles the value back 
and forth.

Figure 4.13: Key Change Event

Inserting Markers in a List Window

There are two types of markers—SMPTE 
markers and bar markers. When you 
insert a marker, the default type is bar 
marker. You can change this to a SMPTE 
marker by clicking the icon. Click in the 
name field and type a new name.

Figure 4.14: Two Different types of Markers

NOTE: SMPTE Markers retain their 
SMPTE times, even if you change the 
tempo or SMPTE offset of the sequence 
using any method. However, they will move 
if you use Move Events—they are not 
“locked.”

Markers are displayed in the Marker pop-
up in the Control Bar (see page 193 in 
your MIDI Reference Manual), and in the 
Tracks Window ruler.

Name fields

Marker Type Icons
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Tempo Track List Windows

Figure 4.15: Insert Event pop-up in Tempo track 
List Window

Inserting a tempo change affects the 
tempo for all tracks in the sequence. The 
Insert Event pop-up for the Tempo track 
contains Tempo as its sole entry.

Figure 4.16: Tempo Change Event

LIST WINDOW MENU

Following is an explanation of the items in 
the List Window menu:
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Auto Scroll (Shift-4)

When checked, Vision follows the 
Counter and scrolls the contents of the 
List Window.

NOTE: If Auto Scroll Top Window 
Only is checked in the Editing section of the 
Settings Window, Vision only scrolls the top 
window.

Jump to Selection (Command-J)

Choose this command to automatically 
scroll the contents of the List Window to 
the Edit In point.

No SMPTE

Turns on and off SMPTE display for event 
times, Edit In/Out points, and track 
length. Bar/beat/unit times are always 
displayed in the List Window.

Absolute SMPTE

This item specifies that absolute SMPTE 
times are displayed. Absolute time values 
are derived from adding the sequence’s 
offset time to actual event times.

NOTE: The offset time for a sequence refer-
ences a SMPTE time (location) on tape, 
usually corresponding to the beginning of a 
song or musical passage.
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Relative SMPTE

This item specifies that relative SMPTE 
times are displayed. Relative time values 
represent the actual elapsed time from 
the beginning of the sequence—without 
adding the sequence’s offset.

Set Default Location

Saves as default the current position and 
size of the List Window. Any newly 
opened List Windows use these defaults.

View (Option-V)

Choose this menu item to open the View 
dialog. It specifies which events are dis-
played in the List Window. And, if the 
track is a “multi,” containing events 
assigned to more than one Instrument, 
you can use this dialog to choose which 
Instruments are displayed.

Figure 4.17: List Window’s View dialog

Instrument
Choices

Event Choices
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For each type of criteria, choose the radio 
button that makes the most sense:

• all
Displays all events or Instruments.

• only
Displays only the selected events or 
Instruments.

• all except
Displays only the events or Instru-
ments not selected.

The View dialog not only determines 
which data is displayed, but also which 
data is editable. Data not displayed, there-
fore, cannot be selected, edited, or 
modified.

There are two checkbox options at the 
bottom of the View dialog. Checking 
either option lets you apply changes in the 
dialog to:

• all open List Windows
• all new List Windows

Play Edited Note

When checked, notes are sounded when 
clicked, or when changing their pitch.

Show Event End Times

When checked, end times for note and 
audio events are displayed, instead of 
event durations.
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Show Event Durations

When checked, durations for note and 
audio events are displayed, instead of end 
times.

Show Release Velocities

Turns on and off the display of release 
velocities for note events. Most MIDI 
devices don’t respond to release veloci-
ties, so you may wish to suppress viewing 
them.

EDITING EVENTS IN THE LIST 
WINDOW

To select events for modification in a List 
Window, click on the event’s selector dot 
at the far left. The selector dot becomes 
an open triangle, signifying that the item 
is selected. The entire event description is 
also highlighted. 

When changing the bar of an event in the 
List Window, the beat and unit are set to 
the beginning of the bar. This makes it 
easy to enter events at bar or beat loca-
tions. To change one of the bar/beat/unit 
numbers without affecting the others, 
Command-click the number.

To select a group of adjacent events, click 
on the first event’s selector dot and drag 
up or down across the events. 

To select many events, click on the first 
event, scroll to the last one, and 
Shift-click. All events between them are 
selected.
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To select several non-adjacent events, 
hold down the Command-key while click-
ing on each of the events. 

Clicking on the time or description of an 
event deselects all currently selected 
events and selects the new event.

NOTE: Use the Select submenu commands 
in the Do menu to utilize rules that aid spe-
cific selection. For a complete description of 
these commands, see page 423 in your 
MIDI Reference Manual.

Event Times and Moving Events

After moving any event in the List Win-
dow, the window scrolls to display the 
event.

Edit the event time to move an individual 
event. Click the bar/beat/unit fields and 
type the desired values (or use the 
mouse).

After entering event times, click else-
where or type the Enter key. The event 
moves to its new location, scrolling the 
window if necessary.

Re-ordering Simultaneous Events

Due to MIDI transmission rates (and pos-
sibly computer processor speed), large 
numbers of simultaneous events can’t all 
be sent at once. If some notes (i.e. drums) 
require more rhythmic precision than 
other notes, move the less important 
notes a unit or two later in time. Since it 
usually takes MIDI about one unit of time 
to send a MIDI event, several simulta-
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neous events are already being 
transmitted over a period of several units. 
Changing some events by a few units 
changes their “priority,” but generally 
doesn’t delay them by a musically signifi-
cant amount. 

Several events occurring at the same time 
can be re-ordered to be transmitted 
sequentially by changing the units field of 
the events. Typing the Enter key displays 
the event in the new order. Use the play-
back quality as a guide indicating whether 
this process is necessary.
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WHAT IS THE STRIP CHART?

The Strip Chart is a powerful editing tool 
found in the Tracks, Pulse, Graphic, and 
Notation Windows. It provides graphic 
viewing and editing of a variety MIDI 
data. The Strip Chart can also be used to 
insert events, and in the process, create 
many interesting musical effects like 
decrescendo, accelerando, or vibrato.

The following event types can be viewed 
and edited in the Strip Chart:

• velocity
• release velocity
• duration
• tempo
• markers (view only)
• patches
• text events (view only) including 

lyrics and copyrights
• aftertouch and poly aftertouch
• pitch bend
• MIDI Controllers (volume, pan, sus-

tain, mod wheel, etc.)
• automation events (including volume, 

pan, mute/solo, send levels, EQ 
enable, and phase inversion)

• EQ band parameter events
• Plug-in parameter events
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Each event in the Strip Chart is displayed 
as a rectangle. The height of the rectangle 
determines the value, the left edge signi-
fies the start time, and the width 
determines the duration of the event.

Figure 5.1: The Strip Chart

The Strip Chart consists of the following 
items:

A I-beam tool
B Pencil tool
C Variable pop-up
D Edit Shapes pop-up
E Strip Chart toggle (shown enabled)
F Strip Chart contents
G Density setting
H Exact toggle (shown disabled)

123 4 5 6 7 8
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Opening the Strip Chart

To open the Strip Chart in the Graphic 
Window, click the Strip Chart toggle at 
the bottom of the Window (see 
Figure 5.2). In addition, choosing an 
event type from the Strip Chart Contents 
pop-up will automatically open the Strip 
Chart.

Figure 5.2: Clicking the Strip Chart toggle

To open the Strip Chart in the Tracks and 
Pulse Windows, click the open/close tri-
angle in the lower-left corner of the 
Window (see Figure 5.3).

Figure 5.3: Opening Strip Chart in Tracks Window

KEYBOARD EQUIVALENT: Type Shift-3 
on your computer keyboard to toggle the 
Strip Chart between open and closed.
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Defining the Strip Chart Contents

To choose the event type displayed in the 
Strip Chart:

a Click on the Contents pop-up and 
select the desired event type.

Figure 5.4: Defining the Strip Chart Contents

Event types contained within the track are 
displayed in bold text in the Contents 
pop-up. This provides immediate feed-
back on which types of data are contained 
in the track. If a track contains only note 
data, the Contents pop-up displays only 
three event types in bold: Velocity, 
Release Velocity, and Duration.

NOTE: Choosing No Strip Chart from the 
Contents pop-up closes the Strip Chart.
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STRIP CHART CONTENTS

Modifying Events in the Strip 
Chart

In the Graphic and Notation Windows, 
the Strip Chart displays information only 
for the track in that window. In this case, 
inserting new events in the Strip Chart 
places the data in the displayed track 
(even if other tracks are selected in the 
Tracks or Pulse Window).

In the Tracks and Pulse Windows, the 
Strip Chart displays information for all 
selected tracks. In this case, inserting 
new events in the Strip Chart places the 
data in each selected track.

However, modifying existing events in the 
Strip Chart modifies all events of that type 
in all selected tracks for the selected time 
range. This is the case for the Strip Chart 
in each edit window (despite the absence 
of these track events in the Graphic and 
Notation Windows).

THE STRIP CHART TOOLS

Figure 5.5: Strip Chart tools

Edit Shapes pop-up

Variable pop-up

Pencil tool (selected)

Strip Chart I-beam tool

Strip Chart toggle (enabled)
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The I-Beam Tool (Select)

Use this tool to click and drag over a 
selected time range in the Strip Chart. 
The I-beam tool in the main window’s tool 
palette works similarly, but each tool 
operates independently. 

The Strip Chart I-beam tool is also inde-
pendent from the Marquee tool in the 
main window’s tool palette.

The Pencil Tool

The Pencil tool allows drawing a new set 
of values for a selected event or group of 
events. It works with the Shapes defined 
in the Edit Shapes pop-up (see page 104).

The Variable pop-up

Figure 5.6: Variable pop-up in the Strip Chart

The Variable pop-up, providing access to 
several types of tools with special func-
tions, works in conjunction with the Edit 
Shapes pop-up.
Opcode Systems, Inc.



CHAPTER 10: The Strip Chart
Scale

• Using the Scale tool, Strip Chart data 
can be modified by a factor ranging 
from 25% to 400%, labelled in the left 
margin. Vision multiplies the value of 
each event by the Scale factor. The 
resulting value is confined to limits 
imposed by the event type.

Figure 5.7: Scale Tool with Straight shape

Add Amount

The Add Amount tool causes values to be 
added to or subtracted from the values of 
the event according to the points on the 
line drawn. 

For example, drawing a sloping line from 
10 to 20 in the time range of notes having 
a velocity of 64, increases the values from 
74 to 84.
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Max/Min Limit

The range of values created by Strip 
Chart edit operations can be limited by 
setting the Variable pop-up to either Max 
or Min Limit. 

For example, values greater than 48 can 
be reduced to 48 by selecting Max Limit 
and drawing a line at 48 across the 
desired time range, leaving all values less 
than 48 unchanged.

Figure 5.8: Max Limit with Flat shape

Legato

In Legato mode, the ending times of 
selected notes are changed with respect 
to their proximity to the next note. The 
duration is changed but not their start 
times.

For example, using Legato on durations 
with a value of 100%, extends each note 
until the beginning of the next note.
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NOTE: Legato is grayed out when the Strip 
Chart displays anything other than note 
durations.

NOTE: The Legato tool in the Strip Chart 
uses the setting in the Select & Modify 
Window (for Change Duration, Set Legato 
to) when deciding the gap size over which 
notes are not affected. For details, see 
page 126 in your MIDI Reference Manual.

Thin

Using Thin eliminates some controller 
data to require fewer events to achieve a 
similar effect. This saves memory and 
speeds up operations. Aftertouch, pitch 
bend, and volume controllers are notori-
ous for clogging up MIDI transmissions 
with high data densities.

For example, if a sequence is mixed and a 
track contains too much volume control-
ler data:

a Choose the Thin tool from the 
Variable pop-up.

b Set the Density to a small amount 
(perhaps 3%).

The Density field is located to the left of 
the Exact mode toggle.

c Drag across the control data to thin.

NOTE: By using Undo, different Density 
settings can be auditioned to find the small-
est setting that produces the desired effect.
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The Density setting can also be increased 
from the current setting, creating interpo-
lated values to “smooth out” overly 
noticeable controller changes.

Compress

The Compress tool compresses and 
expands Strip Chart data while keeping 
the relationships between existing events 
proportional.

For instance, Figure 5.9 shows the Com-
press tool expanding a range of key 
velocities. Notice that the basic shape of 
the data remains similar, but its range is 
expanded to fit the height of the drawn 
rectangle.

Figure 5.9: Expanding data range in Strip Chart 
with Compress tool

To compress the data, draw a rectangle 
around the events with a narrow range—
the events increase or decrease as neces-
sary to fit within the new data range.
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The Compress tool affects all events in 
the time region of the dragged rectangle, 
even if they are above or below it. Events 
at the bottom of the data range are 
assigned a new value corresponding to 
the bottom of the rectangle, events at the 
top of the range are assigned a new value 
corresponding to the top— all others get 
proportional new values somewhere in-
between.

The Edit Shapes Pop-up

Figure 5.10: Edit Shapes pop-up 

Straight

The Straight shape draws a line in any 
direction, making linear changes to Strip 
Chart events.

Free

The Free shape draws a freehand line and 
is especially helpful when using the Pencil 
tool, Min Limit, or Max Limit.
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Parabola

The Parabola shape draws a parabolic 
curve from left to right (steeper at right) 
or from right to left (steeper at left).

The shape and size of the parabola is 
defined by the direction and amount 
dragged:

Figure 5.11: Four parabolas drawn differently, 
arrows indicating the mouse direction 

The Parabola is especially useful when 
creating fade outs:

a With the Strip Chart open, choose 
Volume from the Contents pop-up.

b Select the Pencil tool.

c Choose Parabola from the Edit 
Shapes pop-up.

d Drag a parabola from the top of the 
Strip Chart to the bottom, starting at 
the time to begin fading, and stopping 
at the end of the track.
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Flat

The Flat shape draws straight, horizontal 
lines. All affected data either assumes the 
value drawn, has a constant amount 
added, or is scaled by a constant amount, 
depending on the modification tool 
selected from the Variable pop-up. 

This is especially useful with the Percent 
tool to scale all events by the same 
percentage. 

Random

The Random option drags a rectangular 
selection around the events to randomize. 
Vision randomly chooses values falling 
within the range of the rectangle and 
applies the changes to the selected 
events. When the Variable pop-up is set to 
Add Amount, Vision adds a random 
amount between values outlined. When 
using Scale, Vision chooses random 
values for scaling the selection.
105
Figure 5.12: Using Random on key velocities

The Random option is useful in “humaniz-
ing” notes step-recorded with constant 
velocities.

Oscillator Shapes

Use the Oscillator shapes to insert or 
shape data with periodic waveforms. The 
available waveshapes include Sine, 
Square, Triangle, and Sawtooth. These 
shapes can be used to draw in expression 
data for filter sweeps, or volume data for 
tremolo effects—and they can be in per-
fect sync with your sequences.

Figure 5.13 shows controller events 
inserted with the Sawtooth waveshape.
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Figure 5.13: Drawing events with Sawtooth 
waveshape

The height of the drawn events is deter-
mined by how far up or down you drag 
the mouse after the initial click. The direc-
tion of the waveform is determined by 
whether the mouse was dragged up or 
down.

The Waveform Period is set in the Strip 
Chart & Nudge section of the Settings 
Window, see Figure 5.14, and determines 
the length of each cycle for the Oscillator 
shape. The period can be specified as a 
number of bars, beats, units, seconds, 
frames, or bits.

Figure 5.14: Strip Chart & Nudge settings
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The Waveform Period pop-up also has an 
option called Use Meter. Check this item 
when using “bars” as the period; this 
ensures that the bar’s size is based on the 
Meter for the affected track region. Use 
Meter is checked by default.

Use the Waveform Period along with 
Cursor Quantize to ensure that the wave-
shapes are drawn cleanly on the desired 
beats.

NOTE: When using an Oscillator Shape in 
the Strip Chart with the Pencil tool selected, 
you can click the Pencil tool to automati-
cally open the Settings Window —where the 
Waveform Period may be specified.

NON-CONTINUOUS EVENTS IN 
THE STRIP CHART

The Strip Chart can display many non-
continuous types of events, including 
Mute, Solo, Plug-In Bypass, EQ Enable, 
etc. In these cases, events drawn in the 
top half of the Strip Chart result in an 
“On” event and events drawn in the 
bottom half of the Strip Chart result in an 
“Off” event.

Regardless of where you position the 
pencil tool when inserting these events, 
On events will be drawn at the very top of 
the window and Off events will be drawn 
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at the very bottom of the window. This 
results in a situation where Off events 
themselves cannot be seen in the Strip 
Chart, except as the “end” of an on event.

As a rule of thumb, if you see a colored 
rectangle in the Strip Chart, the parame-
ter selected in the Strip Chart contents 
pop-up is On. If you do not see a colored 
rectangle, the parameter is Off.

USING THE STRIP CHART

This section describes how to use the 
Strip Chart to view and change various 
event types.

NOTE: When editing data in the Strip 
Chart, holding down the Shift-key affects 
only previously selected events.

NOTE: During operations that add to or 
subtract from Strip Chart data, Vision 
automatically limits the resulting values to 
their legal minimum or maximum bounds.

Solo Off event Solo On event
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Velocity and Release Velocity

The Strip Chart displays two types of 
velocity:

• velocity (key velocity)
• release velocity

Since Velocity is not displayed in the 
Graphic or Notation Windows, the Strip 
Chart provides viewing and editing for 
these important events.

When either type of velocity is selected 
from the Strip Chart’s Contents menu, the 
Strip Chart displays a vertical bar for each 
note’s velocity value. The values are 
shown on the left side of the Strip Chart.

An audio event’s velocity setting affects 
the playback volume of the audio event; 
the higher the number is, the louder the 
event will be.

NOTE: While most keyboards and MIDI 
devices send and respond to key velocity, 
few send or respond to release velocity. 
Vision’s default release velocity value is 64; 
if Vision does not receive a release velocity 
setting while recording from a MIDI con-
troller, it sets the release velocity parameter 
to 64.

Duration

Note Durations can be viewed and modi-
fied in the Strip Chart.
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When viewing durations in the Strip 
Chart, vertical bars are displayed denot-
ing the duration for each note. The value 
of the bar is shown on the left side of the 
Strip Chart. The scale maximum is a 
whole note except when Add Amount is 
the selected tool. The scale is then 
denoted by -B to B indicating that a maxi-
mum value of B may be added to or 
subtracted from a note duration.

Figure 5.15: Viewing Durations in the Strip Chart

Tempo

Although tempo events are stored in the 
Tempo track of each sequence, the 
Tempo track is directly editable from the 
Strip Chart—simply choose Tempo from 
the Contents pop-up.
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Editing or inserting tempo events in the 
Strip Chart automatically updates the 
sequence’s Tempo track.

Figure 5.16: Viewing tempo events in the Strip 
Chart

NOTE: When using the Straight tool to 
draw an accelerando or ritardando in the 
Strip Chart, Vision draws a curve instead. 
Linear changes to tempo are not perceived 
as linear, or smooth.

Markers

Markers are stored in the Meter track, 
but can be viewed in any track’s (MIDI or 
Audio) Strip Chart. For example:

If the Markers in your Meter track look like this...

...the Markers would look like this when displayed in the 
Strip Chart.
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Patches

Insert a Patch Change in the Strip Chart 
by using the Pencil tool to click at the 
desired time for the Patch Change. A pop-
up menu appears listing the patches avail-
able for the track’s Instrument.

Figure 5.17: Patch Events in the Strip Chart

If the Instrument doesn’t have names 
assigned in the Names Window, a dialog 
appears allowing numeric entry for bank 
select and program change values:
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Text-type submenu

Figure 5.18: Text-type submenu

Text-type events allow storage of text 
comments, copyright information, 
descriptions of Instruments, lyrics, or cue 
points in tracks, along with MIDI 
information.

The Strip Chart displays each text event 
on its own horizontal text line. When 
enough text events have been displayed 
to fill the entire strip chart (vertically), 
display begins again at the top of the win-
dow. The Strip Chart can only display the 
first 62 characters of any text-type event. 
Text-type events may actually occupy sev-
eral lines in the Text Edit dialog but only 
the information that fits is displayed in the 
Strip Chart.

Text-type events include:

• Text
Can be used for any text including 
comments, reminders etc.

• Copyright
Provides a place to store a copyright 
notice.

• Instruments
Verbal descriptions of Instruments 
can enable subsequent orchestration 
in a different MIDI environment.

• Lyrics
Words may be exported to notation 
programs supporting this feature.
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• Cue Points
Typically describes action taking 
place on film or video occurring at a 
specific SMPTE time.

Inserting a new text-type event opens the 
Text Edit dialog allowing display and edit-
ing for the entire event. Any text can be 
typed in, and cut, copy, and paste opera-
tions can be performed by typing 
Command-X, Command-C, and Com-
mand-Y, respectively (these commands 
are not available from the Edit menu). 
When finished, type the Enter key to 
insert the text into the track.
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MIDI submenu

Figure 5.19: MIDI submenu

MIDI events include:

• Pitch Bend
Pitch Bend events can have values 
from -8192 to +8191. They are dis-
played as events above and below a 
horizontal line. Events above the line 
have positive values, and events 
below the line have negative values.

Figure 5.20: Pitch bend events in the Strip 
Chart
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• Aftertouch
Aftertouch events can have values 
between 0 and 127.

• Poly Aftertouch
When using the Strip Chart to display 
and edit Poly Aftertouch, a note 
number appears in the second pop-up 
next to the Strip Chart’s Contents 
pop-up. The Strip Chart displays and 
edits Poly Aftertouch events for one 
note at a time. To select a different 
note, click the Note pop-up and 
change it using either the mouse or a 
MIDI controller.

Figure 5.21: Viewing Poly Aftertouch in the Strip 
Chart

• Velocity Scale
Velocity Scale events can have values 
between 0 and 127. For more informa-
tion about Velocity Scale, see 
page 297 in your MIDI Reference 
Manual.

Note Affected by Poly Aftertouch
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• MIDI Controllers
A general Controller option and all 
eight Favorite Controllers are avail-
able from the MIDI submenu. To 
define your Favorite Controllers, see 
page in your MIDI Reference Manual.
Choosing any of these items gives 
you a second pop-up containing all 
controller types.
When one of the eight favorite con-
trollers is selected, the name and 
number of the controller appears in 
the second pop-up (to the right of the 
Strip Chart’s Contents pop-up). When 
“Controller” is selected, the second 
pop-up displays Controller 7 (Vol-
ume) by default.
In both cases, any new controller may 
be selected from the second pop-up.

Figure 5.22: Controller pop-up in the Strip 
Chart

Press here...
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• Fine Controls
Vision allows controllers numbered 0-
63 to be in Fine or Coarse mode. In 
Coarse mode, Vision displays and 
edits values in a range of 0-127. In 
Fine mode, controllers 32-63 are 
interpreted as “fine tuning” for con-
trollers 0-31. In this case, the 
combined value limits are 0 to 16383. 
Fine Controls are enabled from the 
Settings Window (see page 331 in 
your MIDI Reference Manual for 
details).
NOTE: Most MIDI devices don’t use 
Fine controls. Consult your device 
manual to find out if this feature is 
available. 

Automation submenu

Figure 5.23: Automation submenu

• Audio Volume
Values can range from negative infin-
ity to +24 dB. For details, see your 
Audio Reference Manual.

• Audio Pan
Values range from <100.00 (left) to 
100.00>(right).
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• Mute
Events drawn in the top half of the 
strip chart will result in a “Mute On” 
event, and events drawn in the 
bottom half will produce a “Mute Off” 
event.
Unlike most of the other commands 
in this menu, Mute can affect Audio 
or MIDI Instruments. Keep in mind 
that these events affect Instruments 
rather than tracks.
For details, see your Audio Reference 
Manual.

• Solo
Events drawn in the top half of the 
strip chart will result in a “Solo On” 
event, and events drawn in the 
bottom half will produce a “Solo Off” 
event.
Unlike most of the other commands 
in this menu, Solo can affect Audio or 
MIDI Instruments. Keep in mind that 
these events affect Instruments 
rather than tracks.
For details, see your Audio Reference 
Manual.

• Send (1-4) Level
These options can write Send Level 
events for each specific send. Values 
range from negative infinity to 
+24 dB.
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• Plug-in (1-4) Bypass
Plug-in Bypass events can have Off 
and On values. When set to Off, the 
plug-in will be applied to the audio 
signal. When set to On, the plug-in 
will be bypassed.
Events drawn in the top half of the 
strip chart will result in a “Plug-in 
Bypass On” event, and events drawn 
in the bottom half will produce a 
“Plug-in Bypass Off” event.

• Phase Invert
Events drawn in the top half of the 
strip chart will result in a “Phase 
Invert On” event, and events drawn in 
the bottom half will produce a “Phase 
Invert Off” event.

• EQ Enable
Events drawn in the top half of the 
strip chart will result in an “EQ 
Enable On” event, and events drawn 
in the bottom half will produce an 
“EQ Enable Off” event.

For more information about these auto-
mation events, please see your Audio 
Reference Manual.

EQ Band Parameter submenu

Figure 5.24: EQ Band Parameter submenu

• Frequency
Controls the frequency of the speci-
fied EQ band. Values can range from 
20.00 Hz to 20000.00 Hz.
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• Gain
Controls the gain of the specified EQ 
band. Values can range from -
18.00 dB to +18.00 dB.

• Width
Controls the width of the specified 
EQ band. Values can range from 0 to 
4.00 octaves.

• Type
Allows you to change the EQ type for 
the specified band.

• Enable
Events drawn in the top half of the 
strip chart will result in a “EQ Band 
Enable On” event, and events drawn 
in the bottom half will produce a “EQ 
Band Enable Off” event for the speci-
fied band.

For more information about these auto-
mation events, please see your Audio 
Reference Manual.
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Plug-in Parameter submenu

The Plug-in Parameter submenu lists 
the plug-ins that are assigned to the 
selected track’s Audio Instrument. For 
example:

Figure 5.25: Plug-in Parameter submenu

After you select a plug-in, another pop-up 
menu appears to the right. This menu dis-
plays the selected plug-in’s parameters. 
For example, if you select opECHO, you 
will see the following:

...then the Plug-in Parameter
submenu looks like this.

If the Console looks like this...
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Open the plug-in edit window for 
opECHO, and you will see that the param-
eters listed in the pop-up menu 
correspond to the parameters of the 
opECHO plug-in.

Vision can automate up to 1024 parame-
ters per VST plug-in.

For more information about these auto-
mation events, please see your Audio 
Reference Manual.

Using the Density Setting

When choosing the Pencil or Thin tools to 
edit continuous automation data, the Den-
sity setting appears next to the second 
Strip Chart pop-up.

Figure 5.26: Density setting in the Strip Chart

Plug-in parameters

Density Setting
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NOTE: The Density setting can also be set 
from the Settings Window. See page 332 in 
your MIDI Reference Manual for details.

MIDI is capable of communicating 
approximately 1000 events per second. If 
pitch bend was entered at this maximum 
speed, MIDI wouldn’t have time to trans-
mit anything but pitch bend. The Density 
setting, scaled from the maximum MIDI 
transmission rate, allows restriction of 
this data to levels that are musically mean-
ingful. The minimum density is 0.1% of 
MIDI capacity.

The goal is to achieve a musical effect 
with controller data, without hearing indi-
vidual steps, while using a minimum 
Density setting. 

Use Undo to audition different Density 
settings to find the smallest setting that 
provides a satisfying musical effect.

When entering pitch bend for a patch 
whose pitch bend range is a whole step, a 
Density of 1% is adequate. If the pitch 
bend range is two or three octaves, a Den-
sity of 20% is appropriate. 

MULTIPLE TRACKS AND 
CHANNELS IN THE STRIP 
CHART

The Strip Chart in the Tracks and Pulse 
Windows can simultaneously display and 
edit data for more than one track. This is 
helpful for scaling or thinning data on sev-
eral tracks at the same time, or for 
inserting identical volume and pan events 
across several tracks.
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Figure 5.27 shows pan data from two sep-
arate tracks being displayed in the Strip 
Chart. Viewing related data from separate 
tracks is useful for checking their 
relationship.

Figure 5.27: Pan data from two separate tracks

Inserting data in the Strip Chart for the 
Tracks and Pulse Windows places the 
data in all selected tracks. If a track is a 
“multi” and contains several channels, a 
copy of the data is inserted for each 
channel.

Although the Strip Chart in the Graphic 
Window cannot display data for multiple 
tracks, it can display data for multiple 
channels if the displayed track is a “multi” 
track. However, it can only insert data on 
one channel at a time (see Figure 5.28). 
Edits, on the other hand, affect all dis-
played channels.

Figure 5.28: Specifying Instrument for inserted 
Strip Chart events
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RESIZING AND ZOOMING THE 
STRIP CHART

The Strip Chart in the Tracks and Pulse 
Windows can be resized and vertically 
zoomed for greater detail and data 
resolution.

Resizing the Strip Chart

To resize the Strip Chart in the Tracks 
and Pulse Windows:

a Open the Strip Chart by clicking the 
open/close triangle in the lower-left 
corner of the Tracks or Pulse 
Window.

b Place your cursor at the top of the 
Strip Chart area so the resize cursor 
( ) appears.
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c Click and drag up to resize the Strip 
Chart area. 

Once the desired size is reached, 
release the mouse button to resize the 
area.

The contents in the Strip Chart are 
redrawn to take advantage of the larger 
edit area.

d If necessary, resize the entire Tracks 
(or Pulse) Window to make room for 
the larger Strip Chart.

Zooming Vertically in the Strip 
Chart

Normally, the entire value range for 
events fits into the height of the Strip 
Chart. You can, however, zoom vertically 
for greater resolution, which can be 
important for inserting and editing data.
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To zoom vertically in the Strip Chart, click 
the Zoom buttons in the lower-right 
corner of the Tracks (or Pulse) Window. 
Make sure not to confuse the vertical 
Zoom buttons for the Strip Chart with 
those of the Track Overview, see 
Figure 5.29.

Figure 5.29: Vertical Zoom buttons and scroll bar 
for Strip Chart

When viewing zoomed data in the Strip 
Chart, use the vertical scroll bar to navi-
gate up or down.

Vertical Zoom buttons
for Track Overview

Vertical Zoom buttons
for Strip Chart

Horizontal Zoom buttons
for both Track Overview
and Strip Chart

Vertical scroll bar
for Strip Chart
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Figure 5.30 illustrates the Strip Chart at 
three different zoom levels. The more you 
zoom vertically, the smaller the displayed 
data range becomes. View the left margin 
of the Strip Chart for the actual range of 
the displayed data.

Figure 5.30: Strip Chart data, zoomed vertically

Displayed value range, 0-127

Displayed value range, 48-79

Displayed value range, 60-68
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